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Abstract

This white paper describes how to prevent information leaks using standard Windows functions. It is intended for IT professionals in charge of managing and maintaining the security of Windows Server in a network environment where Active Directory has already been installed, or is going to be installed in future.
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1. Getting Started

Protection of information (such as personal and confidential information) stored on computer and network is the object of laws and regulations in many countries and regions around the world 
, preventing leaks of confidential information, including personal information, is one of the most important issues for businesses in recent times. Large amounts of information are stored on equipment such as servers and client computers. The issue of how administrators can prevent this information from leaking, yet continue to make effective use of it, is an important one. In the past, the main goal was to prevent malicious users from entering the system from outside. Recently, however, there has been case after case of information leaks involving employees.

Employees may leak information in a variety of ways. As shown in Figure 1-1, these include leaks via e-mail, printed documents, or portable removable storage device such as USB flash memory or floppy disks, lost or stolen laptop PCs, damage caused by spyware or viruses, connecting to an internal wireless or wired network from an unauthorized client, inappropriate or inadequate permission settings, vulnerable passwords, and other people seeing employee's computers or information. It is very difficult to perfectly block all the routes via which information can leak without decreasing productivity.
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Figure 1-1 Risks of Information Leaks from within a Company

This white paper focuses on the more frequent information leakage risks, and those about which many users have given feedback. Specifically, it describes solutions for three types of leaks: leaks via removable storage devices, lost or stolen laptop PCs, and inappropriate or inadequate permission settings.

Remarks

Microsoft offers Windows Rights Management Services (RMS), a solution for protecting important information such as Web content, documents and e-mail. Individual RMS partners also offer many products incorporating Rights Management technology. This white paper does not cover RMS in detail. For more information about RMS, see

http://go.microsoft.com/fwlink/?LinkId=50767
System requirements

The system requirements for implementing the solutions in this white paper are as follows.

Servers

Windows 2000 Server SP4 or Windows Server 2003 (with SP1)

The domain environment should be constructed using Active Directory.

Clients

Windows 2000 Professional SP4 or Windows XP Professional SP1 or SP2

Clients should be inside the same domain.

Other requirements

Internet Explorer (6.0 or later), and Windows Scripting Host (WSH) (5.6 or later) should be installed on both clients and servers.

If Internet Explorer 6.0 or later is installed, you do not have to install WSH 5.6 separately, as it is included in Internet Explorer 6.0 or later. To install WSH 5.6 on its own, download it from http://go.microsoft.com/fwlink/?LinkId=50767.

Remarks

This white paper includes several sample scripts. Some antivirus software may show a warning or prevent these scripts from executing when you try to execute them. In this case, exclude the script from the blocking process by setting it to be recognized as a safe program. After this, make sure that the script works correctly.

2. The Structure of This Document

This white paper describes the following measures for preventing information leaks:

· Restricting the Use of Removable Storage Devices


This section gives a step-by-step procedure for restricting the use of removable storage devices such as USB flash memory or floppy disks, to prevent information leaks via these devices.

· Measures to Prevent Information Leaks Using an Encrypting File System (EFS)
This section describes how to encrypt files in a batch to prevent important information from leaking if your computer is lost or stolen.

· Hiding Personal Information Stored in Active Directory
This section gives a step-by-step procedure for limiting access so that specified users or groups cannot see personal information from users stored in Active Directory.

· Additional Information
This section gives other information which is helpful for preventing information leaks.

Cautions
Microsoft will not be liable for any problems that may occur if you make incorrect changes to the attributes or security settings of Active Directory objects. It is your responsibility to change these attributes correctly.

3. Restricting the Use of Removable Storage Devices

The capacity and convenience of recent portable removable storage devices such as USB flash memory has continued to increase, but from the point of view of information leaks, these improvements present a problem, because they make it easier to copy and walk away with personal and confidential information. This chapter gives a step-by-step explanation of how administrators can restrict the use of removable storage devices such as these in the Active Directory environment.

Removable storage devices discussed

Table 3-1 lists the removable storage devices discussed in this white paper.

Table 3-1 Removable Storage Devices that can be Restricted

	Device
	Preventing Use
	Write Protection

	USB storage devices
	(
	(


	IEEE 1394 storage devices
	(
	

	Floppy disks
	(
	

	SD cards
	(3
	

	CD-R/RW
	
	(



Remarks

In Table 3-1, "USB storage devices" means storage devices connected to a computer via a USB bus, such as an external HDD with a USB connection. In the same way, IEEE 1394 storage devices are storage devices which connect to the computer via an IEEE 1394 bus.

Carry out the following procedure to determine whether you can restrict the use of removable storage devices with the computers you want to manage.

1. Click the icon in Figure 3-1 displayed in the notification area, then click Safely Remove Hardware.
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Figure 3-1 The Safely Remove Hardware Icon

Remarks

You can also display the Safely Remove Hardware dialog box by executing rundll32.exe shell32.dll,Control_RunDLL hotplug.dll from the command line.

2. When the Safely Remove Hardware dialog box appears, select the Display device components check box. If the following message, shown in Figure 3-2, is displayed for the USB device, IEEE 1394 device, or SD card, the use of that device can be restricted.

For USB devices, “USB Mass Storage Device” is displayed, followed by the drive name.

For IEEE 1394 devices, “IEEE 1394 SBP2 Device” is displayed, followed by the drive name.

For SD cards, “Secure Digital Storage Device” is displayed, followed by the drive name.
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Figure 3-2 The Safely Remove Hardware Dialog Box

3. There is also a way of checking whether you can restrict the use of floppy disks or CD-R/RWs. Click the Start button, then click My Computer.

If the floppy disk icon is displayed in the Devices with Removable Storage list, you can restrict the use of floppy disks.

For CD-R/RWs, right-click the CD drive icon and click Properties. If the dialog displayed contains the Write tab, you can restrict the use of the drive.

Carrying Out Processing

This chapter describes two cases of restricting the use of removable storage devices: the case where removable storage devices are installed and the case where there are no removable storage devices.

· If removable storage devices are installed

If you are already using or have used removable storage devices with the computer, those removable storage devices are already installed. In this case, use the Administrative Template (adm) file to configure the client computer to prevent the use of these removable storage devices and write operations using them, via the group policy.

· If removable storage devices are not installed

If you have never used relevant removable storage devices with the computer, place access controls for a specific inf/pnf files using the startup script to place restriction on the installation process when a removable storage device is used for the first time.

To restrict the use of removable storage devices, administrators should take measures in both these cases, via group policies.

3.1. If removable storage devices are installed

If removable storage devices are installed on the computer, the administrator can configure the client computers belonging to the same domain to prevent the use of these removable storage devices and write operations using them via the group policy. There is no need to install a program such as an agent on each client computer.

3.1.1. Saving an adm file

Copy the code for BlockRmStor.adm below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file with the following filename. Select Unicode as the character code for saving the file.

%SystemRoot%\inf\BlockRmStor.adm (C:\Windows\Inf\BlockRmStor.adm by default)

[BlockRmStor.adm]

; Administrative template file for blocking removable storage devices

; Version: 1.0

CLASS MACHINE

CATEGORY !!DisableRemovableStorage

    POLICY !!WriteProtectUsbStor

        #if version >= 4

            SUPPORTED !!SUPPORTED_WindowsXPSP2

        #endif

        EXPLAIN !!WriteProtectUsbStor_Help

        KEYNAME "SYSTEM\CurrentControlSet\Control\StorageDevicePolicies"

        VALUENAME "WriteProtect"

            VALUEON NUMERIC 1

            VALUEOFF NUMERIC 0

    END POLICY

    POLICY !!DisableUsbStor

        EXPLAIN !!DisableUsbStor_Help

        KEYNAME "SYSTEM\CurrentControlSet\Services\USBStor"

        VALUENAME "Start"

            VALUEON NUMERIC 4

            VALUEOFF NUMERIC 3

    END POLICY

    POLICY !!Disable1394Stor

        EXPLAIN !!Disable1394Stor_Help

        KEYNAME "SYSTEM\CurrentControlSet\Services\sbp2port"

        VALUENAME "Start"

            VALUEON NUMERIC 4

            VALUEOFF NUMERIC 0

    END POLICY

    POLICY !!DisableFloppy

        EXPLAIN !!DisableFloppy_Help

        KEYNAME "SYSTEM\CurrentControlSet\Services\Flpydisk"

        VALUENAME "Start"

            VALUEON NUMERIC 4

            VALUEOFF NUMERIC 3

    END POLICY

    POLICY !!DisableSDcard

        #if version >= 4

            SUPPORTED !!SUPPORTED_WindowsXPSP2

        #endif

        EXPLAIN !!DisableSDcard_Help

        KEYNAME "SYSTEM\CurrentControlSet\Services\sffdisk"

        VALUENAME "Start"

            VALUEON NUMERIC 4

            VALUEOFF NUMERIC 3

    END POLICY

    POLICY !!DisableCDBurning

        #if version >= 4

            SUPPORTED !!SUPPORTED_WindowsXPWindowsNET

        #endif

        EXPLAIN !!DisableCDBurning_Help

        KEYNAME "SYSTEM\CurrentControlSet\Services\ImapiService"

        VALUENAME "Start"

            VALUEON NUMERIC 4

            VALUEOFF NUMERIC 3

    END POLICY

END CATEGORY ; DisableRemovableStorage

[strings]

DisableRemovableStorage="Controlling Removable Storage Device"

WriteProtectUsbStor="Prevent write operations to USB Storage Devices"

WriteProtectUsbStor_Help="Prevents users from writing USB storage devices.\n\nIf you enable this setting, all users using this computer will not be able to write USB storage devices. Read operation is allowed."

DisableUsbStor="Disable USB Storage Devices"

DisableUsbStor_Help="Prevents users from using USB storage devices.\n\nIf you enable this setting, all users using this computer will not be able to read and write USB storage devices."

Disable1394Stor="Disable IEEE 1394 Storage Devices"

Disable1394Stor_Help="Prevents users from using IEEE 1394 storage devices.\n\nIf you enable this setting, all users using this computer will not be able to read and write IEEE 1394 storage devices."

DisableFloppy="Disable Floppy Disk"

DisableFloppy_Help="Prevents users from using floppy disk.\n\nIf you enable this setting, all users using this computer will not be able to read and write floppy disk."

DisableSDcard="Disable SD Storage Card"

DisableSDcard_Help="Prevents users from using SD storage card.\n\nIf you enable this setting, all users using this computer will not be able to read and write SD storage card."

DisableCDBurning="Disable CD Burning Feature"

DisableCDBurning_Help="Prevents users from burning CD.\n\nIf you enable this setting, all users using this computer will not be able to burn CD. Read operation is allowed.\n\nNote: This setting does not prevent users from using third-party applications that don't use IMAPI (Image Mastering Applications Programming Interface) to create or modify CDs using a CD writer.\nIf you want to restrict CD burning feature for each user, use "Remove CD Burning features" policy setting in User Configuration\Administrative Templates\Windows Components\Windows Explorer."

SUPPORTED_WindowsXPSP2="Microsoft Windows XP Professional SP2 or later"

SUPPORTED_WindowsXPWindowsNET="Microsoft Windows XP or Windows Server 2003"

3.1.2. Creating a Group Policy Object (GPO)

You can create a Group Policy Object (GPO). The procedures for creating a GPO vary depending on whether the Group Policy Management Console (GPMC) is installed. The procedures to follow in each case are described below.

Remarks

· GPMC is a very powerful tool for managing group policies. To download GPMC and obtain technical information on it, see http://go.microsoft.com/fwlink/?LinkId=8630.

· GPMC runs on Windows XP Professional SP1 or Windows Server 2003 computers, and manages group policies in Windows 2000 and Windows Server 2003 domains.

· GPMC does not run on 64-bit versions of Microsoft Windows.

If GPMC is not installed

4. Click the Start button, point to Administrative Tools, and then click Active Directory Users and Computers.

5. Select the OU to which you want to apply a GPO. Here, we will apply the “Restricting the Use of Removable Storage Devices” above to the “Finance” OU. Expand the domain name node in the console tree and right-click the Finance node.

6. Click Properties. The Finance Properties dialog box appears.

7. Click the Group Policy tab.

8. Click the New button and change “New Group Policy Object” to a new name. Here, change it to “Disable Removable Storage Devices.”
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Figure 3-3 Creating a New GPO

9. Click the Edit button to start the Group Policy Object Editor.

If GPMC is installed

10. Click the Start button, point to Administrative Tools, and then click Group Policy Management.

11. Select the OU to which you want to apply a GPO. Here, we will apply the “Restricting the Use of Removable Storage Devices” above to the “Finance” OU. Expand Group Policy Management\Forest: forest name\Domain\domain name in the console tree and then right-click the Finance node.

12. Click Create and Link a GPO Here.
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Figure 3-4 Creating and Linking a GPO

13. Change “New Group Policy Object” to a new name in the Name box of the New GPO dialog box. Here, change it to “Controlling Removable Storage Devices.”
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Figure 3-5 The New GPO Dialog Box

14. Right-click the “Controlling Removable Storage Devices” node you have created under the Finance node.

15. Click Edit to start the Group Policy Object Editor.
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Figure 3-6 Starting the Group Policy Editor from GPMC

3.1.3. Adding the adm file

16. Expand Computer Configuration\Administrative Templates in the console tree.

17. Right-click the Administrative Templates node and click Add/Remove Templates.

18. Click Add. Select the BlockRmStor.adm file you created in “3.1.1 Saving an adm file” from the policy template list and click Open.
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Figure 3-7 The Add/Remove Templates Dialog Box

19. Click Close to close the Add/Remove Templates dialog box.
20. Click the View menu, and then click Filtering. Clear the Only show policy settings that can be fully managed check box and click OK.
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Figure 3-8 The Filtering Dialog Box

Notes

Unless you clear the Only show policy settings that can be fully managed check box, no items will be in the pane on the right when you select the Controlling Removable Storage Devices node. Make sure you carry out this step.

The items in the Filtering menu will only be displayed in the View menu if you have selected the Administrative Templates node in the console tree. If the items in the Filtering menu are not displayed when you click the View menu, check that the Administrative Templates node has been selected.

21. Check that the policies for all of the removable storage device have been added to Computer Configuration\Administrative Templates\Controlling Removable Storage Devices.
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Figure 3-9 The added Controlling Removable Storage Device Node

22. Double-click the items you want to restrict and select Enabled. Click OK.

23. For example, if you double-click Disable Floppy Disk and select Enabled, you will no longer be able to use floppy disks on computers to which this GPO is applied.
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Figure 3-10 Disable Floppy Disk Properties Dialog Box

24. After you have made these settings, exit the Group Policy Object Editor.

3.1.4. Applying a custom policy to a specific OU

If you carry out the procedure above, the “Controlling Removable Storage Devices” GPO you have created will be applied to the “Finance” OU. This section describes how to apply the same GPO to another OU, the “Sales” OU. Carry out the same procedure to apply the GPO to other OUs.

If GPMC is not installed

25. Right-click the “Sales” OU node in the Active Directory Users and Computers console tree and click Properties.

26. Click the Group Policy tab.

27. Click Add.

28. Click the All tab, and select the “Controlling Removable Storage Devices” GPO you created in “3.1.2 Creating a Group Policy Object (GPO)” from the list of GPOs, and click OK.

29. Click OK to close the Sales Properties dialog box.

If GPMC is installed

30. Expand Group Policy Management\Forest: forest name\Domain\domain name\Group Policy Object in the GPMC console tree.

31. Select “Controlling Removable Storage Devices” and drag and drop it onto the Sales OU node.

32. When the message box shown in Figure 3-11 appears, click OK.
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Figure 3-11 Confirming the GPO Link

33. This will link the “Controlling Removable Storage Devices” GPO to the Sales OU. You can perform the same operation by right-clicking the Sales OU node, selecting Link an Existing GPO and selecting the “Controlling Removable Storage Devices” GPO from the GPO link. Figure 3-12 shows the state when the GPO is linked to the “Sales” OU.
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Figure 3-12 The GPOs and a GPO Linked to the “Sales” OU

Notes

· Consider disabling the Turn off background refresh of Group Policy policy if necessary. If you disable this policy, the settings can be updated while the computer is operating, so that you only need to restart the system once to update the changes added to the restrictions on the use of removable storage devices. If this policy is enabled, you will have to restart the system twice. However, you will have to restart your computer to enable the change in the Turn off background refresh of Group Policy policy itself. This policy is located in Computer Configuration\Administrative Templates\System\Group Policy.

· Use the Group Policy refresh interval for computers policy to set the rate at which the group policy is refreshed in the background. By default, group policies for computers are refreshed every 90 minutes in background, with a random offset of between 0 and 30 minutes. This policy is located in Computer Configuration\Administrative Templates\System\Group Policy.

· These settings are not cleared if you delete the GPO. To return to the original settings, you must disable the settings explicitly by clicking Disabled.

3.2. If removable storage devices are not installed

If removable storage devices are not installed on the computer, you can disable installation of the removable storage devices by changing the permissions of specific files. The administrator can prevent the use of removable storage devices on client computers that belongs to the domain by setting a startup script for the group policy.

There is no need to install a program such as an agent on each client computer.

3.2.1. Starting the Group Policy Editor

If GPMC is not installed

34. Click the Start button, point to Administrative Tools, and then click Active Directory Users and Computers.

35. Here, use the GPO (Disable Removable Storage Devices) you created in “3.1 If removable storage devices are installed.” Expand domain name in the console tree, right-click the Finance OU node and click Properties.

36. Click the Group Policy tab.

37. Click the GPO (Disable Removable Storage Devices) you created in “3.1 If removable storage devices are installed” from the list of linked GPOs.
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Figure 3-13 GPOs Linked to the “Finance” OU

38. Click the Edit button to start the Group Policy Object Editor.

If GPMC is installed

39. Click the Start button, point to Administrative Tools, and then click Group Policy Management.

40. Select the OU to which you want to apply the GPO. Here, use the GPO (Disable Removable Storage Devices) you created in “3.1 If removable storage devices are installed.” Expand Group Policy Management\Forest: forest name\Domain\domain name\Finance in the console tree.
41. Right-click the Disable Removable Storage Devices GPO node.
42. Click Edit to start the Group Policy Object Editor.
3.2.2. Setting the startup script

43. Expand Computer Configuration\Windows Settings\Scripts (Startup/Shutdown) in the console tree on the left.

44. Double-click Startup in the pane on the right to display the Startup Properties dialog box.
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Figure 3-14 The Startup Properties Dialog Box

45. Click the Show Files button to display the folder in another window, as shown below.
    \\domain name\SysVol\domain name\Policies\policy GUID\Machine\Scripts\Startup

The folder path on the domain controller is as follows:

    %SystemRoot%\SysVol\SysVol\domain name\Policies\policy GUID\Machine\Scripts\Startup

46. Copy the code for BlockRmStor.wsf shown below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file in the folder you opened in Step 3 with the name BlockRmStor.wsf. Select UTF-8 as the character code when saving the file.

[BlockRmStor.wsf]

<?xml version="1.0" ?>

<package>

<comment>

'****************************************************************************

'*

'* Copyright (c) Microsoft Corporation. All rights reserved.

'*

'* Module Name:    BlockRmStor.wsf

'* Version:        1.0

'* Abstract:       Enables an administrator to remove ACE of some inf/pnf

'*                 files for specified group to prevent installing

'*                 some removable storage devices.

'*

'****************************************************************************

</comment>

<job>

    <runtime>

        <named

            name="D"

            helpstring="Deny specified group/user access to installing the removable storage devices"

            type="string"

            required="false"

        />

        <named

            name="R"

            helpstring="Revoke specified user/group's access rights to installing the removable storage devices"

            type="string"

            required="false"

        />

        <named

            name="Q"

            helpstring="Turn on Quiet mode, its off by default"

            type="string"

            required="false"

        />

        <example>

Example:

BlockRmStor.wsf /D:Everyone

BlockRmStor.wsf /R:Everyone

BlockRmStor.wsf /D:Everyone /Q

  Specify either /D or /R

        </example>

    </runtime>

    <script language="VBScript">

    <![CDATA[

        Option Explicit

        On Error Resume Next

        Dim objArgs, objFSO, objShell, blnOK, blnQuiet

        Dim strArg, strGroup, strFolder, strFileList

        Dim intCounter, intErr

        Const conWindowsFolder = 0

        Const WSH56_REQUIRED = "This script is expected to work on WSH 5.6 or later."

        Const ERROR_NUM = ": Error 0x"

        strFileList = Array("flpydisk", _

            "usbstor", _

            "sbp2", _

            "sffdisk" )

        Set objShell = CreateObject("WScript.Shell")

        ' This script is expected to work on WSH 5.6 or later

        If WScript.Version < 5.6 Then

            objShell.LogEvent 1,  WSH56_REQUIRED

            WScript.Quit(-1)

        End If

        '---------------------------------------------------------------------

        ' check script usage

        '---------------------------------------------------------------------

        blnOK = False

        blnQuiet = False

        strGroup = ""

        Set objArgs = WScript.Arguments

        Select Case objArgs.Named.Count

            Case 1,2

                If (objArgs.Named.Exists("D")) Then

                    strArg = " /D "

                    strGroup = objArgs.Named("D")

                    blnOK = True

                ElseIf (objArgs.Named.Exists("R")) Then

                    strArg = " /R "

                    strGroup = objArgs.Named("R")

                    blnOK = True

                End If

                If (blnOK = True And objArgs.Named.Exists("Q")) Then

                    blnQuiet = True

                End If

        End Select

        ' if incorrect usage display message and quit

        If Not(blnOK) Then

            WScript.Arguments.ShowUsage

            WScript.Quit(-1)

        End If

        '---------------------------------------------------------------------

        ' Modify ACLs of files

        '---------------------------------------------------------------------

        strFolder = ""

        Set objFSO = CreateObject("Scripting.FileSystemObject")

        ' Build %SystemRoot%\Inf directory

        Set strFolder = objFSO.GetSpecialFolder(conWindowsFolder)

        strFolder = strFolder & "\Inf\"

        ' Modify ACLs of target inf/pnf files

        intCounter = 0

        Do While intCounter <= Ubound(strFileList)

            ' Modify ACLs of .inf file

            ModifyACLsOfFile strArg, strGroup, strFolder, strFileList(intCounter), ".inf"

            ModifyACLsOfFile strArg, strGroup, strFolder, strFileList(intCounter), ".pnf"

            intCounter = intCounter + 1

        Loop

        ' Cleanup

        Set objArgs = Nothing

        Set objShell = Nothing

        Set objFSO = Nothing

        '---------------------------------------------------------------------

        ' Function: Modify ACLs of file to deny specific group access

        '---------------------------------------------------------------------

        Function ModifyACLsOfFile(strArg, strGroup, strFolder, strFilename, strExt)

            On Error Resume Next

            ModifyACLsOfFile = False

            Dim strPathname, strCACLSCmd

            strPathname = ""

            strCACLSCmd = ""

            strPathname = strFolder & strFilename & strExt

            If (objFSO.FileExists(strPathname)) Then

                ' Deny access to the .inf file for specified group

                strCACLSCmd = "cacls.exe """ & strPathname & """ /E" & strArg & """" & strGroup & """"

                DisplayMsg strCACLSCmd

                intErr = objShell.Run(strCACLSCmd, 0, True)

                If intErr = 0 Then

                    ModifyACLsOfFile = True

                Else

                    LogFailureEvent intErr, strCACLSCmd

                End If

            End If

        End Function

        '---------------------------------------------------------------------

        ' Sub: Log Error Event to the Application EventLog

        '---------------------------------------------------------------------

        Sub LogFailureEvent(intErrNum, strErrText)

            On Error Resume Next

            objShell.LogEvent 1,  strErrText & ERROR_NUM & Hex(intErrNum)

        End Sub

        '---------------------------------------------------------------------

        ' Sub: Display a message if blnQuiet = FALSE

        '---------------------------------------------------------------------

        Sub DisplayMsg(strMessage)

            If Not(blnQuiet) Then

                WScript.Echo strMessage

            End If

        End Sub

    ]]>

    </script>

</job>

</package>
47. After checking that BlockRmStor.wsf is displayed in the list, as shown in Figure 3-15, click the Close button (x) in the upper right corner of the window to close it.
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Figure 3-15 The Script List

48. Click Add in the Startup Properties dialog box.

49. Enter “BlockRmStor.wsf” in the Script Name box.

50. Enter “/D:group name  /Q” in the Script Parameters box.

In group name, specify the name of the group to which you want to apply the restrictions on the use of removable storage devices.

   Example: BlockRmStor.wsf /D:Everyone /Q
If the group name contains a whitespace character, enclose it with double quotation marks. The /Q option is a switch that suppresses the output of messages.
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Figure 3-16 The Edit Script Dialog Box

To display the usage of BlockRmStor.wsf, enter “cscript BlockRmStor.wsf” at a command prompt.

51. Click OK to close the Edit Script dialog box.

52. Click OK to close the Startup Properties dialog box.

Remarks

· To return the settings to their original state, execute the same script with different arguments. For example, if restrictions on use have been set for Everyone, you can return this setting to its original state with the /R:group name option, as follows.


BlockRmStor.wsf /R:Everyone

· Unlike logon scripts, startup scripts are executed when the computer starts up, so you do not have to log on the system with an Administrator account to execute startup scripts.

The names of the files whose permissions are changed by BlockRmStor.wsf are listed in Table 3-2. All the files are located in %SystemRoot%\inf.

Table 3-2 List of Files Whose Permissions Are Changed

	Device
	Filename

	Floppy disks
	flpydisk.inf

	
	flpydisk.pnf

	USB storage devices
	usbstor.inf

	
	usbstor.pnf

	IEEE 1394 storage devices
	sbp2.inf

	
	sbp2.pnf

	SD storage cards
	sffdisk.inf

	
	sffdisk.pnf


3.3. Checking settings

If the above settings have been applied, you will no longer be able to use devices for which restrictions on use are set. For example, the icons for 3.5” floppy disks and removable disks will no longer displayed in My Computer. If you insert a removable disk such as a USB storage device, it will not be possible to use it.

If you write-protect a USB storage device, the following errors will appear if you try to write data into it, but you will be able to read data normally.

Table 3-3 Examples of Write Errors

	Write operation
	Error message

	Creating a new file with Explorer
	File filename cannot be created.

The media is write protected.

	Copying a file with Explorer
	Cannot copy filename. The disk is write-protected. 

Remove the write-protection or use another disk.

	Copying a file using the command prompt
	The disk cannot be written to because it is write protected. Please remove the write protection from the volume volume name in drive drive name.


You can check that the startup script has been applied to the client computers normally using one of the following two methods.

The event log

If for some reason a script does not executed normally, an error will be output to the application event log, which you can check with the event viewer. No errors will be output to the event log if the script terminates normally.

cacls.exe

Display the access control list (ACL) for the files on the client computers.

53. Start a command prompt.

54. Execute the following command for each file in Table 3-2.

cacls.exe %SystemRoot%\inf\filename

55. If you specified /D:Everyone as the argument of the BlockRmStor.wsf startup script in “3.2.2 Setting the startup script,” check that “Everyone:N” is included in the result of executing cacls.exe in Step 2; this means that the script has executed normally.

4. Measures to Prevent Information Leaks Using an Encrypting File System (EFS)

If your computer is lost or stolen, important information saved on the hard disk may be leaked. In Windows, you can set a logon password to prevent a third party from logging on the system easily. However, as files are saved in plain text on the hard disk, third parties can easily read them if they remove the hard disk and connect it to another computer or install another operating system. You can increase the security of the computer by encrypting files so that unspecified third parties can no longer view them. This chapter describes how to encrypt files as a batch process.

4.1. Overview of the Encrypting File System
The Encrypting File System (EFS) is a file encrypting technology available with the NTFS file system. It allows users to use encrypted files just as easily as plain text files. It is possible to encrypt individual files, but if you encrypt a folder, all the files that you will create within the folder will be encrypted.

Files encrypted with the Encrypting File System are highly secure, and it is very difficult for a user who does not have the decryption key to decrypt them. This means that even if a computer is stolen, it will be very difficult to view the encrypted data on it.

For example, even if another operating system is installed on the hard disk of the stolen computer and the hard disk is viewed with local administrator privileges, the contents of encrypted files cannot be seen because the user does not have the decryption key.

However, this is not true if the computer is left in a state where it can be operated. Always lock and protect computers with secure passwords when you are away from them.

Notes

· The Encrypting File System is designed to help store data securely on the local hard disk. For this reason, it does not support encryption over network communication paths. You can build more secure environments by using other technologies, such as Internet Protocol Security (IPSec), together with the Encrypting File System.
· If a user who has the decryption key copies or moves an encrypted file to a non-NFTS volume (for example, a FAT32 volume), the file will be decrypted.

4.1.1. The process of deploying the Encrypting File System
Deploy the Encrypting File System as shown below.
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Figure 4-1 Flow Diagram for Deploying the Encrypting File System

4.2. Making a plan for encryption

Determine which folders you need to encrypt, based on your environment and how you use the computer. Make the plan carefully, because the performance of the operating system may be reduced if you encrypt more folders than necessary. The method of encryption will vary depending on the operating system. You must take this into account, for example, when sharing files.

Notes

· When you encrypt a file, the time stamp of the file will change to the time of encryption. The time stamp will also be updated when you decrypt a file.

· With NTFS, it is not possible to have a file which is compressed and encrypted at the same time. If you encrypt a compressed file, the file will be decompressed and its size will increase. If a folder which you are going to encrypt is compressed, take the amount of disk space remaining into account.

4.2.1. Folders and files for which encryption is recommended

It is recommend that you encrypt the following folders to prevent information leaks. All of these folders may hold files containing personal or confidential information.

· My Documents

· Desktop

· Favorites

· Recent Files

· Address book data in Outlook Express

· E-mail data in Outlook Express

This white paper provides a script for performing encryption. By default, it is designed to encrypt the following folder as well.

· The default folder containing the personal folder file (pst) for Outlook

Depending on your company’s policy, other folders may also contain important data. For example, the whole of the D: drive may be used as a data folder.

Change the script so that unnecessary folders are not encrypted, and add any other necessary folders. For details of how to change the script, see “4.4.4 Changing the encryption script.”

Tips

· Temporary Internet Files in Internet Explorer may contain important information. However, encrypting these files would make it difficult to perform tasks such as installing update files. For this reason, it is recommended that you set Internet Explorer to delete temporary Internet files when you exit it. For details of this procedure, see “6. Additional Information.”
· Pagefile may contain plain text data. However, as a pagefile is opened exclusively by the operating system, it cannot be encrypted. You can reduce the risk of improper use of these file by setting the security option in the group policy for erasing virtual memory pagefile when the system is shut down. For more information about the policy for clearing virtual memory pagefile, see 
http://go.microsoft.com/fwlink/?LinkId=51312
· You can encrypt offline files in Windows XP and Windows Server 2003. For more information, see

http://go.microsoft.com/fwlink/?LinkId=51295
4.2.2. Files and folders not to encrypt

The  Encrypting File System provides an extremely high level of security. In principle, only the user who encrypted a file can open it. Windows system accounts and service accounts are no exception to this. This means that if you encrypt a file which is required to start Windows, Windows will no longer start.

If the Windows installer file (.msi) is encrypted, installation from the .msi file will fail. Caution is required if users are to be allowed to install software.

Care is also required when encrypting a shared folder. If shared access to a folder is permitted, users can see whether files are present, but users who do not have the decryption key will be denied access if they try to open a file.

The Temp folder may be used by programs such as update programs to expand a temporary file. If you encrypt this folder, updated files will be expanded with the encryption attribute, which may lead to problems such as access rejection.

On some operating systems, the logon process may fail if you encrypt Autoexec.bat.

Tips

See the following technical information if you want to share access to encrypted files.

http://support.microsoft.com/kb/308991/
4.2.3. If you do not want to encrypt a specific folder

When you encrypt a folder, in principle all the folders under the encrypted folder will be encrypted. However, you may not want to encrypt a specific folder. For example, although you want to encrypt the My Documents folder, you may not want to encrypt the My Web Sites folder inside My Documents.

In this case, you can avoid encrypting the folder by following the procedure below.

56. Open the relevant folder from Explorer.

57. If desktop.ini does not exist, change the settings by following the procedure in Tips. Click the File menu, click New, and then click Text Document.
58. Change the filename from “New text document.txt” to “desktop.ini.”

59. Double-click desktop.ini to open it with Notepad.

60. Add the following text.

[Encryption]
Disable=1
61. Complete the procedure by saving this file.

Tips

By default, desktop.ini is not displayed in Explorer.

1. Open Explorer and click Folder Options in the Tools menu.

2. Click the View tab.

3. Clear the Hide protected operating system files (Recommended) check box in Advanced. Clear the Hide extensions for known file types check box as well.

4.2.4. The differences in encryption methods for different operating systems

The Encrypting File System uses different encryption methods depending on the operating system and service pack.

Table 4-1 Different Encryption Methods

	Operating system
	Encryption method
	Key length

	Windows XP Professional SP1 or later

Windows Server 2003
	AES (Advanced Encryption Standard)

* DESX or 3DES can also be used, by changing the settings.
	· AES: 256 bits

· 3DES: 192 bits

· DESX: 128 bits

	Windows 2000 SP4
	DESX (Data Encryption Standard eXtension)
	· 128 bits


Tips

The default encryption method for Windows XP SP1 or later is AES.

Enabling the 3DES algorithm in Windows XP

You can set the encryption algorithm for the Encrypting File System to 3DES using the local computer policy or group policy.

62. Click Start, and then click Run. Enter “gpedit.msc” and click OK.

63. Expand Computer Configuration\Windows Settings\Security Settings\Local Policy\Security options.
64. Double-click System cryptography: Use FIPS compliant algorithms for encryption, hashing, and signing and set it to Enabled.
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Figure 4-2 FIPS Compliant Algorithms

Tips

The performance of your computer will be reduced when you enable 3DES. It is recommended that you only enable this setting if your organization needs to conform to FIPS.

Changing the encryption method in Windows XP SP1 or later

If you try to display a file encrypted with AES in Windows 2000, which does not support AES, or Windows XP Professional with no service packs applied, the file will appear to be damaged.

To share files with Windows 2000 or Windows XP Professional with no service packs applied, you must set the encryption method to DESX. Since DESX has a short key length (56 bits), it is recommended that clients are updated to Windows XP SP1 or later, so that AES can be used for stronger encryption.

65. Decrypt all the files encrypted with the Encrypting File System..

66. Start the registry editor.

67. Find the following key in the registry and click it.

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\EFS

68. Click New on the Edit menu and specify the following registry values.

Value name: AlgorithmID

Data type: REG_DWORD

Radix: hexadecimal

Data: Use one of the following values.

3DES: 0x6603 (This value is compatible with Windows XP or later versions.)

DESX: 0x6604 (This value is compatible with Windows 2000 and all versions of Windows XP.)

AES_256: 0x6610 (This is the default. It is only compatible with Windows XP with SP1 or a later version.)

69. Exit the registry editor.

70. Restart the computer.

71. Encrypt the files again.

Tips

· If you enable the System cryptography: Use FIPS compliant algorithms for encryption, hashing, and signing group policy, this setting will override the specification and 3DES will be used.

· To check the method used to encrypt a file, use efsinfo.exe in \SUPPORT\TOOLS\SUPPORT.CAB on the Windows Server 2003 CD. You can do this by running efsinfo.exe /k from a command prompt.

· For example, to decrypt all files and folders on the C: drive, enter “cipher.exe /d /a /s:c:\” from a command prompt. Caution is required, as files being used by another process cannot be decrypted.

4.3. Recovery Agents

If an Encrypting File System is used, only the user who encrypted the files can read them. If this user loses the private key used to encrypt the files, no one will be able to read them.

You can specify recovery agents in case this happens, so that users other than the user who encrypted the data can read the contents of files. If there are many recovery agents, encryption will have less effect, so it is recommended that as few recovery agents as possible are set.

The information on recovery agents is saved in individual encrypted files.
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Figure 4-3 An Encrypted File

For this reason, if a recovery agent is added after a file has been encrypted, that recovery agent will not be able to read it.
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Figure 4-4 Recovery Agent 3 is Added after the File has been Encrypted

If you encrypt the file again, the information on the new recovery agent will also be saved in the file. A recovery agent can be added in either of the following ways.

· Running the Cipher.exe /u command.

· A person who can currently decrypt the file opening the file and saving it again.
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Figure 4-5 Encrypting the File Again

Tips

· You can specify more than one recovery agent.

· The private keys for recovery agents can be exported from a computer and stored in an external file. You can specify an option so that private keys are deleted from the computer when they are exported. Exported files are protected with a password.

· You do not need to log on to a system as a user specified as a recovery agent to restore data (i.e., read an encrypted file). The administrator can log on the system with his or her own user account and restore data by importing the private key for a recovery agent.

· To check on recovery agents, use efsinfo.exe in \SUPPORT\TOOLS\SUPPORT.CAB on the installation CD for your operating system. You can do this by running efsinfo.exe /r from a command prompt.

4.3.1. Recovery agents in domains and workgroups

Domain environments

Recovery agents are set using a group policy.

For details of the procedure, see “4.5.1 Adding a recovery agent to a domain.”

Workgroup environments

Recovery agents are set individually for each computer.

Notes

By default, no recovery agents are set in workgroup environments with Windows XP Professional. This means that only the user who encrypted a file can decrypt it.

4.4. Deploying encryption scripts

This section discusses the way to deploy encryption scripts across a company.

Efficient ways to force an encryption script to be used across a company are using logon scripts and distributing the script using Microsoft Systems Management Server.

To allow each user to choose whether to execute a script, you can put the script in a read-only shared folder and allow users to start it from Explorer.

4.4.1. Notes on using encryption scripts

The encryption scripts provided in this white paper call cipher.exe to perform encryption. cipher.exe cannot encrypt files being used by another process. For example, it is not possible to encrypt the Desktop while a user is logged on. This situation can be avoided by using a logon script. For more information, see “4.4.5. Using logon scripts.”

If you encrypt a lot of files, encryption may take a very long time. It will be necessary to keep all end users informed if you encrypt data across the company. See "4.5.3. Estimating encryption time.”

This script does not support decryption. To decrypt files, open the properties for the folder or file in Explorer and clear the Encrypt contents to secure data check box in Advanced. You can also change the script to support decryption.

Notes

The specifications of cipher.exe do not allow you to encrypt read only files or folders using Windows XP SP1 or Windows 2000. For this reason, an access rejection error occurs if you try to encrypt folders such as My Documents, Recent Files or Favorites. This bug has been fixed in Windows XP SP2 and later and Windows Server 2003. For more information about Windows XP SP1, see the following technical information.

http://support.microsoft.com/kb/839220/
If running the encryption script does not encrypt the data, consider removing the read attribute temporarily, encrypting the data and then setting the read attribute again.

4.4.2. Using encryption scripts

Use this encryption script by calling it from wscript.exe or cscript.exe. By default, the script is called from wscript.exe, which displays a simple user interface when you double-click the script. For more information, see “4.5.6. Using encryption scripts manually from Explorer.”

A log file will be saved in %UserProfile%\EFS_username_computer name.log after it executes. For example, the log file might be in the form C:\Documents and Settings\yamada\EFS_yamada_yama00.log.

This naming convention is used to allow you to differentiate logs by their filenames if multiple users are sharing a single computer or a single user is using multiple computers.

Change the script to change the filename or location of the log files. The point which should be changed is shown in the script. Open the script with an application such as Notepad and search for “Logfile name”.
How to use the encryption script

Usage: 

efsenforce.wsf [/Q] [/V] [/P:value] [/T:value]

Options:

Q: Quiet mode. Encrypts without displaying a screen.

V: Verbose mode. The results of executing cipher.exe are recorded in a log file.

P: Postponement mode. Suspends execution for the specified time before beginning encryption. The units are hours. This option cannot be set at the same time as Timer mode.

T: Timer mode. Suspends execution until a specified time before beginning encryption. If the specified time has passed, execution is suspended until the specified time on the following next day. You can specify a time from 0:00 to 23:59. You can also specify a time such as 7:00PM. This option cannot be set at the same time as Postponement mode. If both modes are set, Postponement mode overrides this mode.

Example:

wscript.exe EFSenforce.wsf /Q /V /P:3

Carries out encryption in Quiet mode in three hours' time. The results of executing cipher.exe are recorded in a log file.

cscript.exe EFSenforce.wsf /Q /T:9:30PM

Suspends encryption until 9:30PM, and then executes in Quiet mode.

Tips

In Postponement or Timer mode, the time counts down even if Windows is in hibernation or suspended mode. If Windows returns from hibernation mode when the specified period or time has passed, encryption starts immediately.

4.4.3. Saving the encryption script

Copy the code for EFSenforce.wsf below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file with the filename EFSenforce.wsf in any folder. Select UTF-8 as the character code when saving the file.

[EFSenforce.wsf]

<?xml version="1.0" ?>

<package>

<comment>

'**************************************************************************

'*

'* Copyright (c) Microsoft Corporation. All rights reserved.

'*

'* Module Name:    EFSenforce.wsf

'* Version:            1.0

'* Abstract:          Encrypt specific files and folders.

'*

'*

'**************************************************************************

</comment>

<job>

    <runtime>

        <named

            name="Q"

            helpstring="Quiet mode. Encrypts without displaying a screen."

            type="simple"

            required="false"

        />

        <named

            name="V"

            helpstring="Verbose mode. The results of executing cipher.exe are recorded in a log file."

            type="simple"

            required="false"

        />

        <named

            name="P"

            helpstring="Suspends execution for the specified time before beginning encryption. The units are hours. This option cannot be set at the same time as Timer mode."

            type="string"

            required="false"

        />

        <named

            name="T"

            helpstring="Suspends execution until a specified time before beginning encryption. If the specified time has passed, execution is suspended until the specified time on the following next day. You can specify a time from 0:00 to 23:59. You can also specify a time such as 7:00PM. This option cannot be set at the same time as Postponement mode. If both modes are set, Postponement mode overrides this mode."

            type="string"

            required="false"

        />

        <example>

Example:

 wscript.exe EFSenforce.wsf /Q /V /P:3

- Carries out encryption in Quiet mode in three hours' time. The results of executing cipher.exe are recorded in a log file.

 cscript.exe EFSenforce.wsf /Q /T:9:30PM

- Suspends encryption until 9:30PM, and then executes in Quiet mode.

- Log file location is %UserProfile%\EFS_username_machinename.log.

        </example>

    </runtime>

    <script language="VBScript">

    <![CDATA[

        Option Explicit

        Dim objWScriptShell

        Dim objNet

        Dim objSystem

        Dim objFileSystem

        Dim strAnswer, strTargetFolder, strMode, strVerbose, strOSVer

        Dim i, intSilent

        Dim Log, LogAdd, strLogfile

        Dim intHour, intMaxHour, intOneHour, intMinutes, intOneMinutes, strWakeUpTime, intOneDay

    '--------------------------------------------------------------------------

    ' Localizable strings

    '--------------------------------------------------------------------------

' Dialog  UI

'

        Const strEncStart = "Executes encryption now. Are you sure?"

        Const strEncTerm = "Encryption has been terminated."

        Const strEncTitle = "File Encryption"

        Const strEncPostpone = "Do you want to postpone encryption?"

        Const strEncSchedule = "Please input time to postpone. (1-"

        Const strEncSchedule2 = " hours)"

    ' Console UI & Log

    '

        Const strTitle1 = "========== Encryption script ========== "

        Const strTitle2 = "========== Executes encryption ========== "

        Const strTitle3 = "========== Completes encryption ========== "

        Const strEnc = "Encrypting..."

        Const strSkip = "Encryption skipped: Target folder ="

        Const strLaunchtime = "Start time = "

        Const strComputername = "Computer name = "

        Const strUsername = "User name = "

        Const strVersion = "Version = "

        Const strWSH56 = "WSH 5.6 or later is required to execute this script."

    '

    ' Event Message

        Const strEventMsgStart = "Encryption script started."

        Const strEventMsgFinish = "Encryption script finished."

        Const strEventMsgOutOfSupport = "Encryption script did not start because the version of OS is not supported."

        Const strEventPause1 = "Encryption script will start:"

        Const strEventPause2 = " hour(s) later."

        Const strEventPause3 = "."

    ' Registory location

    '

        Const strOutlookAddressBook = "HKEY_CURRENT_USER\Software\Microsoft\WAB\WAB4\Wab File Name\"

        Const strOutlookMail1 = "HKEY_CURRENT_USER\Identities\"

        Const strOutlookMail2 = "\Software\Microsoft\Outlook Express\5.0\Store Root"

        Const strDefaultUserID = "HKEY_CURRENT_USER\Identities\Default User ID"

    ' Deafult number

    '

        intMaxHour = 8              ' Max hours to postpone

        intOneHour = 60             ' Minutes

        intOneMinutes = 60*1000     ' Millisecond

        intOneDay = 24*60           ' Minutes

    '--------------------------------------------------------------------------

    ' Encryption function

    '

    ' This function encrypts specified folders and files. You can use environment variable

    ' like a %UserProfile%. Some folders are blocked here. 

    ' The following folders are blocked.

    ' NULL, %windir%, %windir%\system32, %SystemDrive%

    '

    '--------------------------------------------------------------------------

    Function Encrypt(strTargetFolder)

        If Right (strTargetFolder, 1) = "\" Then

            strTargetFolder = Left (strTargetFolder, Len (strTargetFolder)-1)

        End If

        Set LogAdd = objFileSystem.OpenTextFile(strLogfile, 8,,-2)

        LogAdd.Write (strEnc & strTargetFolder & VbCrLf)

        LogAdd.Close

        strTargetFolder = Lcase (objWScriptShell.ExpandEnvironmentStrings(strTargetFolder))

    ' Check NULL, %windir%, %windir%\system32, %SystemDrive%

        Select Case strTargetFolder

            Case "", Lcase (objFileSystem.GetSpecialFolder(0)) , Lcase (Left (objFileSystem.GetSpecialFolder(0), 2)) , Lcase(objFileSystem.GetSpecialFolder(1))

            If intSilent <> 0 Then WScript.Echo strSkip & chr(34) & strTargetFolder & chr(34)

            Case Else

            If intSilent <> 0 Then WScript.Echo strEnc & strTargetFolder

            objWScriptShell.run "cmd.exe /C cipher.exe /E /S:" & chr(34) & strTargetFolder & chr(34) & " /A /I" & strVerbose ,0,TRUE

        End Select

    End Function

    '--------------------------------------------------------------------------

    ' Terminate function

    '

    ' This function terminates this script.

    ' Event log is logged.

    '

    '--------------------------------------------------------------------------

    Function Termination()

        strAnswer = MsgBox (strEncTerm, vbOkOnly, strEncTitle)

        objWScriptShell.LogEvent 2, strEncTerm

        WScript.Quit(-1)

    End Function

    '--------------------------------------------------------------------------

    ' Postpone function

    '

    ' This function displays UI for entering postponed hours.

    '

    '--------------------------------------------------------------------------

    Function Postpone()

        strAnswer = MsgBox (strEncPostpone, vbYesNo, strEncTitle)

        If strAnswer = 6 Then

            Do

                intHour = cint(inputbox (strEncSchedule & cstr(intMaxHour) & strEncSchedule2, strEncTitle, "1"))

                If (intHour > 0) and (intHour <= intMaxHour) Then Exit Do

                If intHour = 0 Then Termination

            Loop

        Else

        Termination()

        End If

    End Function

    '--------------------------------------------------------------------------

    ' Checking System Requirements

    ' In case of WSH 5.6 earlier, Win9x or WinNT4

    '

    ' WSH 5.6 or later is required. In case of WSH 5.6 earlier, error code = -1.

    ' In case of Win9x or WinNT4, error code = -1.

    ' Event log is logged.

    '（if you are using Win9x, the log is logged to wsh.log under system folder.）

    '

    '--------------------------------------------------------------------------

    On error resume next

    Set objWScriptShell = CreateObject("WScript.Shell")

        If WScript.Version < 5.6 Then

            objWScriptShell.LogEvent 1, strWSH56

            WScript.Quit(-1)

        End If

    strOSVer = "HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\VersionNumber"

    OScheck(strOSver)

    strOSVer = "HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\CurrentVersion"

    OScheck(strOSver)

    Function OScheck(strOSVer)

        strOSVer = objWScriptShell.RegRead(strOSver)

        If Left (strOSver , 1) = "4" Then

        objWScriptShell.LogEvent 1, strEventMsgOutOfSupport

        WScript.Quit(-1)

        End If

        Err.Clear

    End Function

    '--------------------------------------------------------------------------

    ' Logfile name

    '

    ' Default script will create log file at 

    ' "%UserProfile%\EFS_<username>_<hostname>".

    ' Example is C:\Documents and Settings\Jeffrey\ EFS_Jefrey_JEFF00.log.

    ' If you want to change logfile name and file location, change strLogfile here. 

    ' (Example)

    ' strLogfile = "C:\efs.log"

    ' Logfile will be created as C:\efs.log

    '

    '--------------------------------------------------------------------------

    Set objNet = CreateObject("WScript.Network")

    strLogfile = objWScriptShell.ExpandEnvironmentStrings("%UserProfile%") & "\EFS_" & objNet.UserName & "_" & objNet.ComputerName & ".log"

    '--------------------------------------------------------------------------

    ' Main operation

    '

    ' The script will sleep until configured time when Postpone mode or Timer mode.

    ' Start and end of the script execution are logged to Event log.

    '

    '--------------------------------------------------------------------------

        ArgumentCheck()

        Initialize()

        MainEncryption()

        objWScriptShell.LogEvent 0, strEventMsgFinish

        If strMode = "wscript.exe" Then strAnswer = MsgBox (strEventMsgFinish, vbOkOnly, strEncTitle)

    '--------------------------------------------------------------------------

    ' Check Optional settings.

    '

    ' This script can accept 4 options.

    ' Quiet mode. Unattended encryption.

    ' Verbose mode. Logs the results of cipher.exe to a log file.

    ' Postpone mode. Suspends execution for the specified time before beginning encryption.

    ' This option cannot be set at the same time as Timer mode.

    ' Timer mode. Suspends execution until a specified time before beginning encryption.


' If the specified time has passed, execution is suspended until the specified time


' on the following next day. You can specify a time from 0:00 to 23:59.


' This option cannot be set at the same time as Postponement mode.

    ' Example:

    '  wscript.exe EFSenforce.wsf /Q /V /P:3

    '  - Carries out encryption in Quiet mode in three hours' time. The results of 


'    executing cipher.exe are recorded in a log file.

    '--------------------------------------------------------------------------

    Function ArgumentCheck()

    strVerbose = ""

    intSilent = 1

    intHour = 0

    If WScript.Arguments.Named.Exists("Q") Then intSilent = 0

    If WScript.Arguments.Named.Exists("V") Then strVerbose = " >> " & chr(34) & strLogfile & chr(34)

        objWScriptShell.LogEvent 4, strEventMsgStart

    ' Postpone

    If WScript.Arguments.Named.Exists("P") Then intHour = cint(WScript.Arguments.Named.Item("P"))

    If intHour <0 Then intHour = 0

    If IntHour >intMaxHour Then intHour = intMaxHour

    ' Timer

    If WScript.Arguments.Named.Exists("T") Then strWakeUpTime = WScript.Arguments.Named.Item("T")

    If strWakeUptime <> "" Then

        intMinutes =  (cint(hour(strWakeUpTime))*60 + minute(strWakeUpTime)) - (hour(time)*60 + minute(time))

        If intMinutes <= 0 Then intMinutes = intMinutes + intOneday

    End if

    '

    ' Simple UI is displayed when run on Wscript.exe.

    ' No UI is displayed when /q option is set.

    ' /v option is automatically added in UI mode.

    '

    If intSilent <> 0 Then

        strMode = Lcase (Right (WScript.fullname,11))

        If strMode = "wscript.exe" Then

            intSilent = 0

            strVerbose = " >> " & chr(34) & strLogfile & chr(34)

            strAnswer = MsgBox (strEncStart, vbYesNo, strEncTitle)

            If strAnswer = 7 Then

                Postpone()

            Else

                ' Run immediately if user select to run now

                intMinutes = 0

                intHour = 0

            End If

        End If

    End If

    ' Display postpone message

    If intHour <> 0 Then

        objWScriptShell.LogEvent 4, strEventPause1 & cstr(IntHour) & strEventPause2

        intMinutes = IntHour * intOneHour ' change to minutes

    Else

        If intMinutes <> 0 Then

            objWScriptShell.LogEvent 4, strEventPause1 & strWakeUpTime & strEventPause3

        End If

    End If

    WScript.Sleep intMinutes * intOneMinutes

    End Function

    '--------------------------------------------------------------------------

    '

    ' Initialize logfile

    '

    '--------------------------------------------------------------------------

    Function Initialize()

        Set objFileSystem = CreateObject("Scripting.FileSystemObject")

        Set Log = objFileSystem.CreateTextFile(strLogfile)

        Log.WriteLine(strTitle1)

        If intSilent <> 0 Then WScript.Echo strTitle1

    '

    ' Current Time

    '

        Log.WriteLine(strLaunchtime & Now)

        If intSilent <> 0 Then WScript.Echo strLaunchtime & Now

    '

    ' Hostname and user name

    '

        Log.WriteLine(strComputername & objNet.ComputerName)

        If intSilent <> 0 Then     WScript.Echo strComputername & objNet.ComputerName

        Log.WriteLine(strUsername & objNet.UserDomain & "\" & objNet.UserName)

        If intSilent <> 0 Then     WScript.Echo strUsername & objNet.UserDomain & "\" & objNet.UserName

        Log.WriteLine("")

        If intSilent <> 0 Then     WScript.Echo ""

    '

    ' OS name and version

    '

        For each objSystem in GetObject("winmgmts:").InstancesOf ("Win32_OperatingSystem")

            Log.WriteLine(objSystem.Caption)

            If intSilent <> 0 Then     WScript.Echo objSystem.Caption

            Log.WriteLine(strVersion + objSystem.Version)

            If intSilent <> 0 Then     WScript.Echo strVersion + objSystem.Version

            Log.WriteLine("")

            If intSilent <> 0 Then     WScript.Echo ""

        Next

    End Function

    '--------------------------------------------------------------------------

    '

    ' Main encryption

    '

    '--------------------------------------------------------------------------

    Function MainEncryption

    Log.WriteLine(strTitle2)

    If intSilent <> 0 Then     WScript.Echo strTitle2

    Log.close

    On error resume next

    '

    ' Encrypts My Documents folder

    '

        Encrypt (objWScriptShell.SpecialFolders("MyDocuments"))

    '

    ' Encrypts Desktop folder

    '

        Encrypt (objWScriptShell.SpecialFolders("Desktop"))

    '

    ' Encrypts Favorites folder

    '

        Encrypt (objWScriptShell.SpecialFolders("Favorites"))

    '

    ' Encrypts Recent documents folder

    '

        Encrypt (objWScriptShell.SpecialFolders("Recent"))

    '

    ' Encrypts Outlook Express address book folder

    '

        strTargetFolder = objFileSystem.GetParentFoldername(objWScriptShell.RegRead(strOutlookAddressBook))

        If Err.Number = 0 Then Encrypt (strTargetFolder) else Err.Clear

    '

    ' Encrypts Outlook Express mail data

    '

        strTargetFolder = objWScriptShell.RegRead(strOutlookMail1 & objWScriptShell.RegRead(strDefaultUserID) & strOutlookMail2)

        If Err.Number = 0 Then Encrypt (strTargetFolder) else Err.Clear

    '

    ' Encrypts default folder of Outlook mail data

    '

        Encrypt ("%UserProfile%\Local Settings\Application Data\Microsoft\Outlook")

    '

    ' Finish

    '

        If intSilent <> 0 Then WScript.Echo strTitle3

        Set LogAdd = objFileSystem.OpenTextFile(strLogfile, 8,,-2)

        LogAdd.Write (strTitle3)

        LogAdd.Close

    End Function

    ]]>

    </script>

</job>

</package>
4.4.4. Changing the encryption script

Change the script as necessary, for example to meet your company’s policy.

For example, if you encrypt the drive containing the system (the C: drive by default), the operating system may fail to start up. For this reason, you should decide on which folders are encrypted carefully. It is also recommended that the script is thoroughly verified in a test environment before being deployed across the company.

This section describes how to leave the Favorites folder unencrypted and add the script to encrypt the whole D: drive.

Leaving the Favorites folder unencrypted

Open EFSenforce.wsf with Notepad and find the following line.

    '

    ' Encrypts folder of Favorites
    '

        Encrypt (objWScriptShell.SpecialFolders("Favorites"))
Add a single quotation mark at the start of the line beginning with Encrypt.

'        Encrypt (objWScriptShell.SpecialFolders("Favorites"))

This makes the part encrypting the Favorites folder into a comment, meaning that the code will not be executed.

Encrypting the whole D: drive

Open EFSenforce.wsf with Notepad and find the following line.

    On error resume next
    '

    ' Encrypts folder of My Documents
    '

        Encrypt (objWScriptShell.SpecialFolders("MyDocuments"))
Under the line

    On error resume next
add the following lines.

    '

    ' Encrypt “D:\”
    '

        Encrypt ("D:\")
This will encrypt the whole D: drive.

Notes

This encryption script is set to refuse to encrypt the root folders for %windir%, %windir%\system32 and %SystemDrive%. This is because the operating system may fail to start if these folders are encrypted.

As another example, if you encrypt the folder containing a file used by a service, the service will no longer be able to view the file, which may affect the use of the service, but this script does not refuse to encrypt such files. Carry out the proper verification before adding to the folders or files to encrypt.

4.4.5. Using logon scripts

If a logon script is set, it will execute when a user logs on the domain. It is recommended that a logon script is set for domain users to make sure encryption is performed. It is not always possible to encrypt a desktop folder while a user is logged on, but it can be encrypted by changing the settings in a logon script.

Creating a Group Policy Object (GPO)

You can create a Group Policy Object (GPO). The procedures for creating a GPO vary depending on whether the Group Policy Management Console (GPMC) is installed. The following section describes each of these cases.

Remarks

· GPMC is a very powerful tool for managing group policies. To download GPMC and obtain technical information on it, see http://go.microsoft.com/fwlink/?LinkId=8630.

· GPMC runs on Windows XP Professional SP1 or Windows Server 2003 computers, and manages group policies in Windows 2000 and Windows Server 2003 domains.

· GPMC does not run on 64-bit versions of Microsoft Windows.

If GPMC is not installed

72. Click the Start button, point to Administrative Tools, and then click Active Directory Users and Computers.

73. Select the OU to which you want to apply the GPO. Here, we will apply “Encrypt important files” to the “Finance” OU. Expand the domain name node in the console tree and right-click the Finance node.

74. Click Properties. The Finance Properties dialog box appears.

75. Click the Group Policy tab.

76. Click the New button and change “New Group Policy Object” to a new name. Here, change it to “Encrypt important files.”

77. Click the Edit button to start the Group Policy Object Editor.

If GPMC is installed

78. Click the Start button, point to Administrative Tools, and then click Group Policy Management.

79. Select the OU to which you want to apply the GPO. Here, we will apply “Encrypt important files” to the “Finance” OU. Expand Group Policy Management\Forest: forest name\Domain\domain name in the console tree and then right-click the Finance node.

80. Click Create and Link a GPO Here.

81. Change “New Group Policy Object” to a new name in the Name box of the New GPO dialog box. Here, change it to “Encrypt important files.”

82. Right-click the “Encrypt important files” node you have created under the Finance node.

83. Click Edit to start the Group Policy Object Editor.

Setting a logon or logoff script

84. Expand User Configuration\Windows Settings\Script (Logon/Logoff) in the console tree on the left.
85. Double-click Logon in the pane on the right to display the Logon Properties dialog box.

86. When you click Show Files, another window will appear, displaying the following folder:
    \\domain name\SysVol\domain name\Policies\policy GUID\User\Scripts\Logon
    The folder path on the domain controller is as follows.
    %SystemRoot%\SysVol\SysVol\domain name\Policies\policy GUID\User\Scripts\Logon

87. Drag and drop the EFSenforce.wsf file to copy it to the folder displayed in Step 3.

88. Click the Close button (x) in the top right corner of the folder window to close the window.
89. Click Add in the Logon Properties dialog box.

90. Enter “efsenforce.wsf” in the Script Name box.

91. Enter “/q /v” in the Script Parameters box. Always set the /q option. This hides the screen, so that the user cannot cancel the script. For details of how to use efsenforce.wsf, see “How to use the encryption script” in “4.4.2. Using encryption scripts.” You can also enter and run “cscript efsenforce.wsf /?” or “wscript efsenforce.wsf /?” at a command prompt.

92. Click OK to close the Edit Script dialog box.

93. Click OK to close the Logon Properties dialog box.

Encrypting the desktop folder

The desktop folder cannot be encrypted if another process is using it. To encrypt this folder, you must make the following additional settings to account for the logon script.

94. Start the Group Policy Object Editor.

95. Expand Computer Configuration\Administrative Templates\System\Script in the console tree on the left.

96. Double-click Run logon scripts synchronously in the pane on the right to display the Run logon scripts synchronously Properties dialog box.

97. Select Enabled. Click OK.

Notes

If logon scripts are run synchronously, the Windows Explorer interface program waits for the execution of the scripts to complete before starting. If a folder being encrypted contains a lot of plain text files, encryption may take quite a long time, and the desktop screen may not be displayed for a while. For a way to estimate the encryption time, see “4.5.3. Estimating encryption time.” Once the files have been encrypted, the script will finish executing quickly, even if there are a lot of files.

It is recommended that most folders and files are encrypted in advance by executing a script such as the logon or logoff script before executing the logon script synchronously. For example, you might set the logon script and add synchronous execution two weeks later.

4.4.6. Distributing Scripts with Systems Management Server 2003

This section describes how to distribute the encryption script with Microsoft Systems Management Server 2003 (SMS).

If a script is distributed with SMS, it can be distributed at a specified time, but the Desktop folder cannot be encrypted if another process is accessing it. It is recommended that a logon script is used to encrypt Desktop folders.

Package definition files for distributing encryption scripts

Copy the code for EFSenforce.sms shown below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file with the filename EFSenforce.sms. Select ANSI as the character code for saving the file.

[EFSenforce.sms]

[PDF]

    Version = 2.0

[Package Definition]

    Language = All

    Publisher = Microsoft

    Name = Encryption Script

    Comment = Script will encrypt specific folders.

    Programs = QuietEncryption, ManualEncryption

    MIFPublisher = Microsoft

    MIFName = EFSenforce

[QuietEncryption]

    Name = Enforce encryption

    Comment = Enforce encryption. Script logs the output of cipher.exe.

    CommandLine = cscript.exe efsenforce.wsf /v /q

    EstimatedDiskSpace =

    EstimatedRunTime =

    Run = Hidden

    AfterRunning =

    CanRunWhen = UserLoggedOn

    UserInputRequired = False

    UseInstallAccount = False

    AdminRightsRequired = False

    Assignment = EveryUser

    SupportedClients = Win NT(i386)

    Win NT(i386) MinVersion1 = 5.0.0000.0

[ManualEncryption]

    Name = Encryption by user

    Comment = Simple UI is displayed. Script logs the output of cipher.exe.

    CommandLine = wscript.exe efsenforce.wsf

    EstimatedDiskSpace =

    EstimatedRunTime =

    AfterRunning =

    CanRunWhen = UserLoggedOn

    UserInputRequired = True

    UseInstallAccount = False

    AdminRightsRequired = False

    Assignment = EveryUser

    SupportedClients = Win NT(i386)

    Win NT(i386) MinVersion1 = 5.0.0000.0
Overview of Procedure

98. Import the package definition file for encryption scripts (EFSenforce.sms) and create an SMS package.

99. Specify the path of the source file for the encryption script in the package.

100. Distribute the SMS package to the distribution points.

101. Create the information for notifying SMS clients about the encryption script.

This procedure is described in detail in “4.5.5. Distributing encryption scripts with Systems Management Server 2003.” This section is intended for users who understand SMS and have practical knowledge about distributing software. It is assumed that an SMS infrastructure has already been built or will be built before the encryption script is deployed. For more information about SMS, see “SMS 2003 Concepts, Planning, and Deployment Guide” and “SMS 2003 Operations Guide.” For specific information on software distribution, see “Chapter 5 Distributing Software" in the “SMS 2003 Operations Guide.”

See the following document on security at the Microsoft Web site about using SMS safely. Product documentations can also be downloaded from the site.
Microsoft Systems Management Server Web site

http://go.microsoft.com/fwlink/?LinkId=50912
4.5. Tips

This section introduces some useful functions and methods related to encryption scripts and Encrypting File Systems.

4.5.1. Adding a recovery agent to a domain

This section describes how to add a domain recovery agent.

If GPMC is not installed

102. Click the Start button, point to Administrative Tools, and then click Active Directory Users and Computers.

103. Right-click the domain name node.

104. Click Properties. The domain name Properties dialog box appears.

105. Click the Group Policy tab.

106. Click the New button and change “New Group Policy Object” to a new name. Here, change it to “Add a recovery agent.”

107. Click the Edit button to start the Group Policy Object Editor.

If GPMC is installed

108. Click the Start button, point to Administrative Tools, and then click Group Policy Management.

109. Here, we will apply the settings described in “Adding Encrypt and Decrypt to the Explorer context menu” above to the whole domain. Expand Group Policy Management\Forest: forest name\Domain in the console tree and right-click the domain name node.

110. Click Create and Link a GPO Here.
111. Change “New Group Policy Object” to a new name in the Name box of the New GPO dialog box. Here, change it to “Add a recovery agent.”

112. Right-click the “Add a recovery agent” node you have created under the domain name node.

113. Click Edit to start the Group Policy Object Editor.

Adding a data recovery agent

114. Expand Computer Configuration\Windows Settings\Security Settings\Public Key Policies\Encrypting File System in the console tree.

115. Right-click the Encrypting File System node and click Add Data Recovery Agent.
116. The Welcome to the Add Recovery Agent Wizard dialog box appears. Click Next.
117. Specify the recovery agent you want to add in the Select Recovery Agents dialog box. Click Next.
118. Click Finish.
119. Exit the Group Policy Object Editor.

4.5.2. How to perform verification after executing an encryption script, and verification points

You decided on the folders to encrypt in “4.2. Making a plan for encryption.” This section describes how to verify that these folders have been encrypted.

Carry out the following procedure to perform a verification on each client computer.

120. Select Details from the View menu in Explorer.

121. Select Choose Details on the View menu and choose the Attributes check box.

122. If “E” is displayed in the Attributes field, the file has been encrypted.

Tips

In Windows XP and Windows Server 2003, encrypted folders and files are displayed in green in Explorer.

If the files are not encrypted as you intended, view the log file or encrypt them directly from Explorer.

You can view the encryption status of a file by specifying the folder and executing cipher.exe, without the need to specify options such as /e or /d. Although files and folders with the hidden attribute or the system attribute are not displayed by default, you can show these files by specifying the /h option.

4.5.3. Estimating encryption time

This section introduces a way of estimating the time encryption will take. Note that this is only an estimate, as each computer has a different specification, and conditions such as performance will different depending on whether the computer is a desktop or laptop PC.

The time taken for encryption is roughly proportional to the total size of the files being encrypted. If your computer takes 30 seconds to encrypt 100MB of data, it will take about 60 seconds to encrypt 200MB of data.

For a given total file size, it tends to take longer if there are more files being encrypted. If the total size of the files you are encrypting is about 1GB, encrypting ten thousand 100KB files may take ten times longer than encrypting ten 100MB files.

Computers equipped with faster CPUs tend to encrypt data in less time. The following graph shows a set of results measured in environments which were almost identical except for the CPU used.
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Figure 4-6 Indication of Encryption Time

The following gives an indication of the time required for encryption. As the values vary significantly depending on the environment used, it is recommended that you measure the time in the actual environment if you need a more accurate time.

Reference values

It takes about 250 seconds to encrypt 1GB of data on a 2GHz desktop PC.

It takes about 150 seconds to encrypt 1GB of data on a 3GHz desktop PC.

4.5.4. Adding Encrypt and Decrypt to the Explorer context menu

When you select and right-click a folder or file from Explorer, a context menu appears. You can add Encrypt and Decrypt to this context menu. This is simpler than the standard procedure of opening the properties of the folder or file and selecting the Encrypt contents to secure data check box from Advanced.

Encrypt is displayed on the context menu for folders and files which are not encrypted, and Decrypt is displayed on the context menu of encrypted folders and files.
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Figure 4-7 Encrypt and Decrypt Added to the Context Menu

Tips

Change the following registry values.

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced

Value name: EncryptionContextMenu

Data type: REG_DWORD

Data: 1

How to distribute scripts using an Active Directory policy

Create an adm file and set it as a group policy to add the Encrypt and Decrypt menus to the context menu on client computers belonging to the domain. There is no need to install the program on each client.

Importing and setting the adm file

Copy the code for EFSmenu.adm shown below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file with the following filename. Select Unicode as the character code for saving the file.

%SystemRoot%\inf\EFSmenu.adm (C:\Windows\Inf\EFSmenu.adm by default)

[EFSmenu.adm]

; Administrative template file for extending Windows explorer menu for EFS

; Version: 1.0

CLASS MACHINE

CATEGORY !!WindowsComponents

    CATEGORY !!EnableEncryptionMenu

        POLICY !!EncryptionMenu

            EXPLAIN !!EncryptionMenu_Help

            KEYNAME "SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\Advanced"

                VALUENAME "EncryptionContextMenu"

                VALUEON NUMERIC 1

                VALUEOFF NUMERIC 0

        END POLICY

    END CATEGORY ;; EnableEncryptionMenu

END CATEGORY ;; WindowsComponents

[strings]

WindowsComponents="Windows Components"

EnableEncryptionMenu="Explorer Context Menu Extention"

EncryptionMenu="Add Encryption into Context Menu"

EncryptionMenu_Help="Add encryption menu items to the context menu of Windows Explorer for all computer users using this computer.\n\nIf you enable this setting, Encrypt and Decrypt menus are added to the context menu of Explorer for all users using this computer.\n\nEncrypt menu will be added for plain text files and Decrypt menu will be added for encrypted files."
Creating a Group Policy Object (GPO)

You can create a Group Policy Object (GPO). The procedures for creating a GPO vary depending on whether the Group Policy Management Console (GPMC) is installed. The following section describes each of these cases.

If GPMC is not installed

123. Click the Start button, point to Administrative Tools, and then click Active Directory Users and Computers.

124. Right-click the domain name node.

125. Click Properties. The domain name Properties dialog box appears.

126. Click the Group Policy tab.

127. Click the New button and change “New Group Policy Object” to a new name. Here, change it to “Add encryption menu.”

128. Click the Edit button to start the Group Policy Object Editor.

If GPMC is installed

129. Click the Start button, point to Administrative Tools, and then click Group Policy Management.

130. Here, we will apply “Add encryption menu” to the whole domain. Expand Group Policy Management\Forest: forest name\Domain in the console tree and right-click the domain name node.

131. Click Create and Link a GPO Here.

132. Change “New Group Policy Object” to a new name in the Name box of the New GPO dialog box. Here, change it to “Add encryption menu.”

133. Right-click the “Add encryption menu” node you have created under the domain name node.

134. Click Edit to start the Group Policy Object Editor.

Adding the adm file

135. Expand Computer Configuration\Administrative Templates in the console tree.

136. Right-click the Administrative Templates node and click Add/Remove Templates.

137. Click Add. Select the EFSmenu.adm file you created in “Importing and setting the adm file” above from the policy template list and click Open.

138. Click Close to close the Add/Remove Templates dialog box.

139. Click the View menu, and then click Filtering. Clear the Only show policy settings that can be fully managed check box and click OK.

140. Check that the Add Encryption into Context Menu policy is added to \Computer Configuration\Administrative Templates\Windows Components\Explorer Context Menu Extension.
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Figure 4-8 Displaying Add Encryption into Context Menu
141. Double-click Add Encryption into Context Menu and select Enabled. Click OK.

142. After you have made these settings, exit the Group Policy Object Editor.

Notes

· If you omit Step 5, nothing will be displayed in the pane on the right when you click Explorer Context Menu Extensions in Step 6. The Filtering menu items will only be displayed on the View menu when you select the Administrative Templates node in the console tree. If the Filtering menu is not displayed when you click the View menu, check that the Administrative Templates node is selected.

· To update the policy right away, execute gpupdate.exe.

In Windows 2000, execute the following command.

secedit.exe /refreshpolicy machine_policy

· These settings are not cleared if you delete the GPO. To return to the original settings, you must disable the settings explicitly by clicking Disabled.

· To apply this policy to an OU, you must add a computer object to the OU. It is not possible to make this setting separately for individual users.

4.5.5. Details of distributing encryption scripts with Systems Management Server 2003

Carry out the following procedure to distribute an encryption script with Systems Management Server (SMS).

Creating an SMS package

To distribute software with SMS, you must first create an SMS package that includes instructions for the file and software distribution process. To create a SMS package, set up the location for the package source file (SMS obtains files from package source files) and package definition file (.sms), so that the encryption script can be distributed.

A package definition file is a file in a special format that includes all the information required to create an SMS package. As soon as you import this file, SMS starts creating a package. Once you have created a package using the package definition file, you can change it in the same way as with other SMS packages.

All predefined SMS packages include an SMS program. This is a command line program executed on every computer being managed to control the installation of packages. These programs contain options created for installing packages, in various different combinations. For example, in a definition for an encryption script package, there may be a program for executing an encryption script using user input or a program for executing the script without user input. These SMS programs are compatible with the installation files for packages.

Preparing the SMS package

143. Connect to a folder on the shared network folder or the local computer which stores the source file.

144. Create a source file folder for the encryption script in the shared network or local folder.

145. Copy the encryption script file (EFSenforce.wsf) that you saved in “4.4.3. Saving the encryption script” to the source file folder you created in Step 2.

Creating a package on a site

146. Start the SMS Management Console and expand the tree. Find the site where you want to create the package and click Package.

147. Right-click Package, point to New and click Package From Definition.

148. When the Create Package from Definition Wizard starts, click Next.

149. To import the package definition file for encryption script, click View, specify the package definition file (EFSenforce.sms) you created in “4.4.6. Distributing Scripts with Systems Management Server 2003” and click OK.

150. Click Next.

151. Click Always obtain files from a source directory on the Source Files page and then click Next.

152. Enter the path of the package source file (for example, c:\EFSscript) in the Source Directory box.

This is the same path that you specified in Step 3 in “Preparing the SMS package” above.

153. Click Next and then click Finish.

154. Expand the tree on the SMS Management Console, click a new package and click Program.

155. Double-click the name of the program to expand it in Name in the details pane.

156. On the General tab, check that the predefined command line is the appropriate setup command.

Edit the command line as necessary, adding or deleting options.

157. To check and change the options for controlling the way the program will execute, click the Requirements, Environment or Advanced tab, as necessary.

For more details about the options on these tabs, see the “SMS 2003 Operations Guide.”

158. If you have made any changes, click Apply, and then click OK to save the changes.

Tips

Do not change the default setting for Run with user’s rights under Run mode on the Environment tab when you create a package. Changing this will allow users other than the logon user to execute the encryption script, which will make executing the encryption script meaningless.

Distributing the SMS package to distribution points

Once you have created an SMS package for the encryption script, you can distribute it to distribution points. A distribution point is a shared network folder used by client computers to access the source files of the packages.

Carry out the following procedure to distribute the SMS package to distribution points.

159. Click Package on the SMS Management Console, click the SMS package created for the encryption script and then click Distribution Points.

160. Point to New on the Action menu and then click Distribution Points.

161. When the New Distribution Points Wizard starts, click Next and select the distribution point to use.

162. Click Finish to start distributing.

Notes

The distribution points must have enough disk capacity for the SMS package.

For details of how to use the SMS Management Console to check the amount of free disk capacity at distribution points, refer to the “SMS 2003 Operations Guide.”

Creating Advertisements

After distributing the SMS package to distribution points, create the information which will be advertised to SMS clients.

163. Create or select the collection of SMS clients where the encryption script is to be executed. You can create a collection using either a query based membership rule or a direct membership rule.

For more details about creating collections, see the “SMS 2003 Operations Guide.”

164. Right-click the collection that is to receive the programs in Collections in the console tree, click All Tasks and then click Distribute Software.

165. When the Distribute Software to Collection Wizard appears, click Next.

166. Click Select an existing package, click the SMS package for encryption scripts in the Package box and then click Next.

167. Check that the distribution points you want to use are selected on the Distribution Points page and then click Next.

168. Click the program to advertise in the Programs box on the Select a Program to Advertise page and click Next.

169. Enter the name of the advertisement in the Name box on the Advertisement Name page if necessary and click Next.

170. Specify the subcollection that you want to receives this advertisement on the Advertise to Subcollections page, and then click Next.

171. Check and change the times of the advertisements, and set their expiration date on the Advertisement Schedule page, and then click Next.

172. Click Yes, Assign the program on the Assign Program page. This makes the advertisement mandatory, and enforces the installation of the advertised package.

You must select the date and time to execute the mandatory program.

173. Click Next and then click Finish. The SMS clients will update their list of advertised programs at the polling intervals set in the configuration. The default interval is 60 minutes. When the client has received the advertisement for the encryption script and the advertisement has been assigned (made mandatory), it will be displayed in Run Advertised Programs on the control panel or executed at the specified time.

4.5.6. Using encryption scripts manually from Explorer

If you start an encryption script from Explorer, it starts from wscript.exe by default. In this case, a simple user interface appears. The /v option is automatically added to leave logs containing details such as the files that were encrypted, in case the script is started by accident.

The process when a script is started from wscript.exe

174. Double-click the EFSenforce.wsf file in Explorer.

175. A dialog box asking whether you want to encrypt data immediately will appear.
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Figure 4-9 The “Starting Encryption” Encryption Script Dialog

If you click Yes, encryption will start immediately. When the encryption script has finished, the finish dialog box will appear.

If you click No, a dialog box asking whether you want to defer encryption appears.

176. A dialog box for deferring encryption appears.
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Figure 4-10 The “Deferring Encryption” Encryption Script Dialog 

If you click Yes here, you can postpone encryption for one to eight hours. The default setting is 1 hour.
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Figure 4-11 The “Deferred Time” Encryption Script Dialog

If you click No, the script will be stopped.

177. The encryption script will be executed after the specified time has passed. When the encryption script has finished, the finish dialog box will appear.

4.5.7. Event logs

This encryption script records messages in an event log. The event log is useful for troubleshooting. This log is recorded as the “WSH” source.

Table 4-2 Event Log Messages

	State
	Type
	Message

	When the script starts
	Information
	Encryption script started.

	When the script finishes
	Information
	Encryption script finished.

	When the script is deferred
	Information
	Encryption script will start: n hour(s) later.

	When the script is scheduled
	Information
	Encryption script will start: hh:mm.

	When encryption is interrupted from the UI
	Warning
	Encryption terminated.
* This message is not recorded in the event log if you delete the WSH task.

	When the script is executed in an environment where WSH 5.6 or earlier is installed
	Error
	This script requires WSH 5.6 or later.


4.5.8. Technical information

This section gives technical information on the Encrypting File Systems provided by Microsoft.

Windows XP

· 223316 Best practices for the Encrypting File System
· 241201 How to back up the recovery agent Encrypting File System private key 

· 307877 How to Encrypt a File in Windows XP
· 308989 How to Encrypt a Folder in Windows XP
· 308991 HOW TO: Share Access to an Encrypted File in Windows XP
· 308993 How To Remove File Encryption in Windows XP
· 320166 HOW TO: Identify Encrypted Files in Windows XP
· 418415 What to do if an EFS Recovery Agent Cannot be Added
· 887414 How to add an EFS recovery agent in Windows XP Professional
Windows Server 2003

· 324897 How to manage Encrypting File Systems in Windows Server 2003 Enterprise Server
· 814599 HOW TO: Use Cipher.exe to Overwrite Deleted Data in Windows Server 2003
Windows 2000

· 223316 Best practices for the Encrypting File System
· 230520 [NT] How to encrypt data using an EFS in Windows 2000
· 241201 How to back up the recovery agent Encrypting File System private key 
· 243026 [NT] How to find encrypted file information using Efsinfo_exe
· 243035 How To Disable/Enable EFS on a Stand-Alone Windows 2000-Based Computer
· 255742 Methods for Recovering Encrypted Data Files
· 257705 HOW TO: Reinitialize the EDRP on a Workgroup Computer Running Windows 2000
· 302093 HOW TO: Prevent Files from Being Encrypted When Copied to a Server
· 310114 HOW TO: export certificates in Windows 2000
· 313277 HOW TO: Use Ntbackup to Recover an Encrypted File or Folder in Windows 2000
· 313365 HOW TO: configure the EFS recovery policy for a domain in Windows 2000
· 315672 How To Use Cipher.exe to Overwrite Deleted Data in Windows
· 320044 How to encrypt files and folders on a remote Windows 2000 Server
IIS

· 243756 How To Use Encrypting File System (EFS) with Internet Information Services
5. Hiding Personal Information Stored in Active Directory

Active Directory may contain various types of personal information. While this is very convenient, in the default configuration, all the domain users can view the personal information of all users. You may want to disallow specific groups or organizations from viewing the personal information of specific users, or allow only specific groups or organizations to view personal information.

This chapter gives a step-by-step procedure for making these configurations, using specific examples.

5.1. Example of an Active Directory structure

This chapter explains how to configure Active Directory using a directory structure like the one shown in Figure 5-1. When you actually make the settings, use real names for OUs and groups as appropriate.
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Figure 5-1 Example of a Directory Structure

As shown in Figure 5-1, Domain example.local has three OUs (Organizational Unit), Finance, Sales and Marketing, under which are individual users and groups with those users as members. In this example, there are only three OUs immediately below the domain, and every user and client computer object belongs to one of the OUs. The actual structure may be a little more complicated, so change the settings as appropriate, based on this example.

5.2. An actual scenario

For simplicity, we will use the hypothetical scenario in Figure 5-2, which is based on the directory structure in Figure 5-1.
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Figure 5-2 Example of a Scenario

· (1) Allowed to access personal information

· (2) Not allowed to access personal information

In this scenario, users belonging to the “Finance” OU can view the personal information in their own group, but are not allowed to view the personal information of the users in the “Sales” and “Marketing” OUs.

Notes

Personal information here refers to the collection (property set) of the many user attributes that contain personal information, rather than the individual attributes of Active Directory users. The property set of personal information includes the properties on the Address tab and Telephones tab, and Phone, Office and the other information on the General tab in the User Properties dialog box. For a list of attributes in the property set of personal information, see the following information.

· %SystemRoot%\Help\aclui.chm (In the contents, expand Access control, Concepts, Using Access Control, and click Active Directory object permissions. After this, expand “Property Sets” in the pane on the right.)

· http://go.microsoft.com/fwlink/?LinkId=50765
To restrict permissions based on individual attributes alone rather than by personal information property sets, carry out the procedure in “Step by step” in this chapter, taking “personal information” to mean a specific attribute (for example, “mobile phone numbers”).

5.3. Step by step

An outline of the process for creating the scenario described in the previous section is shown in Figure 5-3.
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Figure 5-3 Outline of the Process

178. Installing the necessary tools

Install the Active Directory Schema snap-in and support tools.

179. Settings for preventing access to the personal information of new users

Disallow Authenticated Users from reading the personal information property sets of new users.

Allow the Sales and Marketing Groups to access the personal information of new users.

180. Allow users in the Sales, Marketing and Finance Groups to read the personal information property sets of new users in the “Finance” OU. However, only users in the “Sales” and “Marketing” OUs should be allowed to read the personal information property sets of new users in the “Sales” and “Marketing” OUs.

181. Settings for disallowing access to the personal information of existing users

The changes to the permissions in Steps 2 and 3 are only valid for new users, and do not affect permissions for existing users. Accordingly, you should forbid users in the “Finance” OU from reading the personal information property sets of existing users in the “Sales” and “Marketing” OUs.

The detailed procedure for each process is described below.

Notes

The processes described in this chapter change the permissions of schema attributes and user object properties. While these properties are basically attributes used for advertising, changes like these may affect the behavior of some applications. It is strongly recommended that compatibility with applications is verified in advance if you are using a directory application that accesses personal information.

5.3.1. Installing the necessary tools

Install the tools required to carry out the processes described in this document in advance. These tools are the Active Directory Schema snap-in and the Windows support tools.

Installing the Active Directory Schema snap-in

182. Open a command prompt.

183. Enter the following command. 

    regsvr32 schmmgmt.dll

This command registers schmmgmt.dll on your computer.

184. Click the Start button and then click Run. Enter “mmc /a” and click OK.

185. From the File menu, click Add/Remove Snap-in and then click Add. 

186. In Snap-in, double-click Active Directory Schema, click Close and then click OK.
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Figure 5-4 The Add/Remove Snap-in Dialog Box

187. To save the console, click Save As on the File menu.

188. Point to the system root directory\system32 directory in Save in.

189. Enter “schmmgmt.msc” in the File Name box and click Save.

190. Creating a shortcut on the Start menu

· Right-click the Start button, click Open All Users, and then double-click the Programs folder and the Administrative Tools folder, in that order. 

· Point to New on the File menu and click Shortcut. 

· Enter “schmmgmt.msc” in the Type the location of the item box in the Create Shortcut wizard and click Next.
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Figure 5-5 Creating a Shortcut

· Enter “Active Directory Schema” in the Type a name for this shortcut box on the Select a Title for the Program page and click Finish.
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Figure 5-6 Specifying a Name

Installing the Windows support tools

191. Insert the Windows CD-ROM into the CD-ROM drive.

192. When a message asking whether you want to re-install Windows appears, click No.

193. When the startup screen appears, click Perform additional tasks and then click Browse this CD.

194. Go to the \Support\Tools folder. For general information about setting up, view the Readme.htm file in this folder.

195. Double-click suptools.msi.

196. Follow the instructions on the screen.

Notes

· You must be a member of the Administrators group on the local computer or have the appropriate rights to perform this procedure. A member of the Domain Admins group may be able to perform this procedure using the computer that is part of the domain. The best practice in terms of security is to use Run As for this procedure.

· As the setup program installs all the Windows support tools on the hard disk, a maximum of 24 MB of free space will be needed on the hard disk.

5.3.2. Settings for preventing access to the personal information of new users

Prepare the Active Directory Schema snap-in, and change the permissions for the schema for the personal information property sets of users.

Clearing the permissions for reading personal information in the User schema

197. Click the Start menu, point to Administrative Tools, and then click Active Directory Schema.

198. Expand the Class node, right-click the user node and click Properties.
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Figure 5-7 The Active Directory Schema Snap-In

199. Click the Default Security tab.

200. Click Authenticated Users in the Group or user names box.

201. Clear Allow for Read Personal Information in the Permissions for Authenticated Users list.
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Figure 5-8 The Dialog Box for User Class Permission Entries

Remarks

It may not be possible to clear the Allow check box for Read Personal Information in Windows 2000 Server. In this case, carry out the following process first.

4. 
Click the Start menu, point to Programs, Administrative Tools, and then click Active Directory Schema.

5. Right-click the root node, Active Directory Schema, in the console tree and click Operations Master.

6. Choose the The Schema may be modified on this Domain Controller check box.

202. Click OK to close the dialog box.

This setting prevents Authenticated Users from reading personal information. However, the Pre-Windows 2000 Compatible Access group which contains the Authenticated Users still has permission to read information by default, so we must change this setting next.

Changing the members of the Pre-Windows 2000 Compatible Access group

203. Click the Start menu, point to Administrative Tools, and then click Active Directory Users and Computers.

204. Double-click the domain name node in the console tree on the left, and then click the Builtin node.
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Figure 5-9 The Active Directory Users and Computers Snap-In

205. Double-click Pre-Windows 2000 Compatible Access in the details pane on the right to display the Properties dialog box.

206. Click the Members tab, and click Authenticated Users in the Members list.
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Figure 5-10 Pre-Windows 2000 Compatible Access Properties
207.  Click the Remove button to delete Authenticated Users from the members of the group. When the confirmation message box asking “Do you want to remove the selected member(s) from the group?” appears, click Yes.

208. Click OK to close the dialog box.

When this has been done, only users with administrative rights will be able to view any personal information created from then on which belongs to new users.

5.3.3. Allowing a specific OU to access personal information

Next we will make settings to allow the personal information of new users to be viewed. Change the settings in the access control list (ACL) for each OU to reflect the following conditions:

· All users can view the personal information of users in the “Finance” OU.

· Users in the Sales and Marketing Groups can view the personal information of the users in the “Sales” OU, but users in the Finance Group cannot.

· Users in the Sales Group and the Marketing Group can view the personal information of the users in the “Marketing” OU, but users in the Finance Group cannot.

as shown in Figure 5-2.

Allowing access to the personal information of Finance users

Allow the Finance, Sales and Marketing Groups to access the personal information of users in the “Finance” OU as follows.

209. Click the Start menu, point to Administrative Tools and then click Active Directory Users and Computers.

210. Click the View menu and then click Advanced Features. Note that the Security tab is not displayed unless Advanced Features is selected.
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Figure 5-11 The Advanced Features Menu

211. Double-click the domain name node in the console tree on the left and then right-click Finance.

212. Click Properties and then click the Security tab.
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Figure 5-12 The Dialog Box for Finance Permissions Entries 

213. Click the Advanced button.

214. Click the Add button, enter “Sales Group” and then click OK.
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Figure 5-13 The Object Picker

215. Click the Properties tab and select User objects for Apply onto.

216. Choose Allow for Read Personal Information in the Permissions list.
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Figure 5-14 The Dialog Box for Finance Permissions Entries

217. Click OK to close the dialog box.

218. Carry out Steps 6 to 9 for the Marketing Group and the Finance Group separately.

Notes

The permissions set here are inherited by child objects.

Allowing access to the personal information of Sales users

Allow the Sales Group and the Marketing Group to access the personal information of the users in the “Sales” OU as follows.

Carry out Steps 1 to 10 in “Allowing access to the personal information of Finance users” above for the “Sales” OU.

Allowing access to the personal information of Marketing users

Allow the Sales Group and the Marketing Group to access the personal information of the users in the “Marketing” OU as follows.

Perform Steps 1 to 10 in “Allowing access to the personal information of Finance users” above for the “Marketing” OU.

When this has been done, the Sales and Marketing Groups will be allowed to access the personal information of new users, but the Finance Group will not. However, the Finance Group will be allowed to access the personal information of users within the “Finance” OU.

5.3.4. Preventing the Finance Group from accessing personal information

At this point, since the ACL settings before the change are still valid for the existing users, Finance users will also be allowed to access the personal information of existing users in other OUs.

Prevent this group from accessing existing users by executing the script in the following procedure.

Saving the script

Copy the code for HidePersonalInfo.wsf shown below, open Notepad and paste it in. Make sure that you copy all of the code. Save the file with the filename HidePersonalInfo.wsf in any folder. Select UTF-8 as the character code when saving the file.

[HidePersonalInfo.wsf]

<?xml version="1.0" ?>

<package>

<comment>

'****************************************************************************

'*

'* Copyright (c) Microsoft Corporation. All rights reserved.

'*

'* Module Name:    HidePersonalInfo.wsf

'* Version:        1.0

'* Abstract:       Enables an administrator to hide Personal Information

'*                 property set of users under specified OU from specified

'*                 group.

'*

'****************************************************************************

</comment>

<job>

    <runtime>

        <named

            name="O"

            helpstring="Target OU to hide Personal Information"

            type="string"

            required="true"

        />

        <named

            name="G"

            helpstring="Group to deny access to the Personal Information"

            type="string"

            required="true"

        />

        <example>

Example:

HidePersonalInfo.wsf /O:"OU=Sales,DC=example,DC=com" /G:example\FinanceGroup

- Specify OU name in DN form

- Specify group name in UPN or domain\group form

        </example>

    </runtime>

    <script language="VBScript">

    <![CDATA[

        Option Explicit

        On Error Resume Next

        Dim objContainer, objUser, blnOK, objShell, objExec

        Dim strOU, strGroup, strDSACLSCmd, strOutput

        Const OU_NOT_FOUND = "Specified OU may not exist. "

        Const WSH56_REQUIRED = "This script is expected to work on WSH 5.6 or later."

        Const ERROR_NUM = ": Error 0x"

        ' This script is expected to work on WSH 5.6 or later

        If WScript.Version < 5.6 Then

            WScript.Echo WSH56_REQUIRED

            WScript.Quit

        End If

        '---------------------------------------------------------------------

        ' check script usage

        '---------------------------------------------------------------------

        blnOK = False

        Select Case WScript.Arguments.Named.Count

            Case 2

                If (WScript.Arguments.Named.Exists("O")) Then

                    If (WScript.Arguments.Named.Exists("G")) Then

                        blnOK = True

                    End If

                End If

        End Select

        ' if incorrect usage display message and quit

        If Not(blnOK) Then

            WScript.Arguments.ShowUsage

            WScript.Quit(-1)

        End If

        '---------------------------------------------------------------------

        ' DACL configuration

        '---------------------------------------------------------------------

        strOU = ""

        strGroup = ""

        Err.Number = 0

        strOU = WScript.Arguments.Named("O")

        strGroup = WScript.Arguments.Named("G")

        Set objShell = CreateObject("WScript.Shell")

        Set objContainer = GetObject("LDAP://" & strOU)

        If (Err.Number <> 0) Then

            BailOnFailure Err.Number, OU_NOT_FOUND

        End If

        ' Set filter to enum user objects only

        objContainer.Filter = Array("user")

        ' Execute dsacls.exe for every user under the OU

        '   to deny specified group RW rights to Personal Information property set

        For Each objUser in objContainer

            strDSACLSCmd = "dsacls.exe """ & objUser.Name & "," & strOU & """ /D """ & strGroup & ":RPWP;Personal Information"""

            On Error GoTo 0

            Set objExec = objShell.Exec(strDSACLSCmd)

            WScript.Echo strDSACLSCmd

            strOutput = ""

            If Not(objExec.StdOut.AtEndOfStream) Then

                strOutput = objExec.StdOut.ReadAll

            End If

            ' For getting final status/exit code

            Do While objExec.Status = 0

                WScript.Sleep 100

            Loop

            ' Show error message only if exit code is non-zero

            If (objExec.ExitCode <> 0) Then

                WScript.Echo strOutput

                BailOnFailure objExec.ExitCode, "dsacls"

            End If

        Next

        ' Cleanup

        Set objExec = Nothing

        Set objShell = Nothing

        Set objContainer = Nothing

        '---------------------------------------------------------------------

        ' Sub: Bail On Failure

        '---------------------------------------------------------------------

        Sub BailOnFailure(intErrNum, strErrText)

            On Error Resume Next

            WScript.Echo strErrText & ERROR_NUM & Hex(intErrNum)

            WScript.Quit(-1)

        End Sub

    ]]>

    </script>

</job>

</package>
If you execute the command without specifying an argument, or with the /? option, the usage instructions for the script will be displayed.

cscript HidePersonalInfo.wsf /?
Preventing the Finance group from accessing the personal information of Sales users

Prevent the Finance Group from accessing the personal information of existing users in the “Sales” OU by executing the following script.

cscript HidePersonalInfo.wsf /O:"OU=Sales,DC=example,DC=com" /G:example\FinanceGroup
Preventing the Finance group from accessing the personal information of Marketing users

Prevent the Finance Group from accessing the personal information of existing users in the “Marketing” OU by executing the following script.

cscript HidePersonalInfo.wsf /O:"OU=Marketing,DC=example,DC=com" /G:example\FinanceGroup

When this has been done, Finance users will not be allowed to access the personal information of existing users in other groups (in this case, the Sales and Marketing Groups), although they will be able to access the personal information of Finance users.

5.3.5. The Exchange offline address book

This section gives additional procedures to carry out in environments where Exchange Server and Outlook are used. Here, it is assumed that Exchange Server 2003 and Outlook 2003 are being used.

If the procedure above has been carried out, the lists of properties of Sales or Marketing users displayed in the online address book of a Finance user will be blank, because the user cannot access that information. However, if users download the offline address book in cache mode, they will be able to read the personal information of all the users in the address book. This is because Exchange Server uses the permissions for reading Active Directory properties rather than individual user account privileges when it creates an offline address book. The offline address book is shared by all users and it is not possible to create separate versions for individual users.

This section describes how to create an offline address book that all users are allowed to read, which contains the minimum necessary number of users. Doing this prevents clients from obtaining personal information on users which they are not allowed to read by downloading an address book. This means that even if a mobile PC is lost or stolen, there is no danger that an address book containing all the information on users will be read. The disadvantages of this method are that the quality of the user experience of reading the address book offline will decrease, and the network performance will be reduced due to the increase in the amount of communication with the Exchange Server. It will not be possible to view an address book that includes all the users when offline. It will be possible to view an address book containing all users when online, but this will be an online address book, not the offline address book which has been copied to the local computer.

Configuring the offline address book for Exchange Server

Carry out the following server settings.

219. Click the Start, point to All Programs, Microsoft Exchange and then click System Manager.

220. Expand organization name (Exchange)\Recipient in the console tree.

221. Right-click All Address Lists, click New, and then click Address List.

222. The Create Exchange Address List dialog box appears. Enter any name in the Address list name box. As an example, if there is an account called “Helpdesk” whose properties can be disclosed to all users, enter “Helpdesk”.

223. Click Filter rules.

224. Click the Advanced tab, click Field, click User, and then click Email Address. Select Starts with from the Condition box and enter “Helpdesk” for Value.

225. Click Find Now, check that all the search results are accounts that can be disclosed, and then click OK.

226. Click Finish.

227. Expand organization name (Exchange)\Recipient\Offline Address List in the console tree.

228. Double-click Default Offline Address List.

229. Delete all items from Address List and click the Add button.

230. When the Select Address Lists window appears, click the Advanced button and then click Find Now.

231. Select the item you created earlier, Helpdesk, from the Search Results list and click OK.

232. Click OK to close the Select Address Lists dialog box.

233. Click OK to close the Offline Properties dialog box.

Notes

· If you create a new offline address book instead of modifying the existing offline address list, set the new offline address book as the new default. Expand Server\server name\First Storage Group, right-click Mailbox Store and click Properties to change a specific offline address list on the General tab in Mailbox Store Properties.

·  If you right-click an offline address list in the Offline Address List container and click Rebuild, the offline address book will be rebuilt. However, note that depending on how large your organization is, this operation may take some time.

· To check that the offline address list has been created, carry out the following procedure in System Manager. Expand Folder\Public Folder\OFFLINE ADDRESS BOOK\/o=organization name/cn=addrlists/cn=oab/cn=name to check that a new item has been generated in the OAB Version 2 and OAB Version 3a nodes. By default, the address book is updated at 5:00 a.m. every day.
 
Setting the order of the Outlook 2003 address list

Carry out the following settings on the client.

234. Start Outlook 2003.

235. Click the Tools menu and then click Address Book.

236. Click the Tools menu and then click Options.

237. Select Global Address List from the Show this address list first box.

238. Click the Add button, select Global Address List from Address List and click the Add button.

239. Move to the beginning of Global Address List with the Up arrow  button.

240. Click OK to close the Address dialog box.

5.4. Checking the behavior of the program

After you have made the settings above, check how the details in property sets for personal information are actually hidden. This section shows the change in the way the personal information for “Sales” and “Marketing” users is displayed in Outlook and Explorer when you log on to the system as a user from the “Finance” OU, in the example scenario in Figure 5-2.

Outlook 2003 – Displaying user properties in the global address list

When you log on the system as a Finance user, the user properties displayed in the Outlook address book are changed by the above process, as shown in Figures 5-15 and 5-16. You can see that after the process has been carried out, values such as the address, phone, fax, home phone number and mobile phone number are no longer displayed.
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Figure 5-15 User Properties in the Address Book Before and After Processing - General Tab
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Figure 5-16 User Properties in the Address Book Before and After Processing - Phone/Notes Tab

Notes

· Part of the personal information property set (for example, the mobile phone number) can be viewed using Outlook Web Access (OWA) or Outlook Mobile Access (OMA). However, as OWA and OMA use a service account (in IIS 6.0, Local System or Network Service by default) rather than a user account to access Active Directory, the above values will be displayed even after personal information is hidden using the method in this chapter. To limit the range of the directory service search in OWA, see http://support.microsoft.com/kb/822940/.

· If the Windows logon account of a user is different from the user's Outlook account, the settings for permissions and restrictions on reading personal information will be applied to the Windows logon user. One possible case where this applies is where several users log on the system in turn with a single shared user account, but use individual Outlook accounts.

Displaying user properties with the Active Directory Users and Computers snap-in

Figures 5-17, 5-18 and 5-19 show a comparison of the display of user properties in the Active Directory Users and Computers snap-in before and after the process is carried out. You can see that as with Outlook, values such as the user's address, phone, fax, home phone number and mobile phone number are no longer displayed when the user properties are displayed with “Finance OU” user rights.
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Figure 5-17 User Properties Before and After Processing - General Tab
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Figure 5-18 User Properties Before and After Processing - Address Tab
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Figure 5-19 User Properties Before and After Processing - Telephones Tab

Searching for and displaying user information in Explorer

241. Log on to the system as a Finance user with access restrictions.

242. Click the Start button, right-click My Documents and then click Properties.

243. Click the Security tab and then click the Add button.

244. Click the Advanced button.

245. Right-click the header of the list (the title area which contains items such as Name (RDN)) at the bottom of the Select Users, Computers or Groups window and click Select Columns.

246. Select the personal information attributes you want to display from Columns available list in the Select Columns dialog box and click the Add button. After adding the necessary attributes, click OK to close the dialog box.

247. Click the Object Types button.

248. As you need to search for users, clear the Built-in security principal and Groups check boxes. Click OK to close the dialog box.

249. Click Find Now.

Before the processing is performed, the search results in Figure 5-20 will be displayed.
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Figure 5-20 Results of User Search before Processing
If you carry out a search in the same way after the processing, the results in Figure 5-21 will be shown. You can see that the personal information for Sales and Marketing users (such as addresses and phone numbers) is blank, because you do not have permission to read this information. You can also see that it is possible to read the personal information for Finance users, who belong to the same OU, without any problem, in the same way as before the processing.
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Figure 5-21 Results of User Search after Processing
Displaying personal information using the DS command

This section shows an example of displaying personal information using the DS command, a command line tool. In the following example, we will log on the system as a user belonging to the “Finance” OU and list the mobile phone numbers of all users in the “Sales” OU. The actual command line is as follows:

dsquery user “OU=sales,dc=example,dc=local” | dsget user –display -mobile

The mobile phone numbers of all the users are displayed before processing, but not after processing.
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Figure 5-22 Example of Executing the ds Command before Processing
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Figure 5-23 Example of Executing the ds Command after Processing

Notes

The DS command is included in Windows Server 2003 and later versions. To use the DS command in Windows XP, you must install the Windows Server 2003 administration tools pack. For more information about the Windows Server 2003 administration tools pack, see http://support.microsoft.com/kb/304718/.

6. Additional Information

This chapter provides useful information for preventing information leaks that was not covered in Chapters 3 to 5, such as information about group policies.

Security settings for Internet Explorer

There are several useful group policies for preventing information leaks in the Internet Explorer settings. You can make these settings using the following group policy.

Before viewing Internet Explorer Maintenance, right-click Internet Explorer Maintenance in the console tree and then click to enable Preference Mode.

User Configuration\Windows Settings\Internet Explorer Maintenance\Advanced\Internet Settings\Advanced

When you double-click this item, the Internet Settings Properties dialog box will appear. The following section describes some of the policy and restriction trees.

AutoComplete sets whether AutoComplete is used for usernames or passwords on forms.

Advanced contains a lot of settings. For example, if you set Delete saved pages when browser closed, the temporary internet files will be deleted when the browser is closed.

These settings are especially effective in shared computer environments.

Protection using screen savers
You can use the following group policy to make settings related to the use of the screen saver for a user.

User Configuration\Administrative Templates\Control Panel\Screen

Password protect the screen saver determines whether the screen saver is protected with the password used for the computer. If you enable this policy, the computer is protected by a password when the screen saver is turned off.

Screen Saver enables the screen saver.

Screen Saver timeout specifies the length of time before the screen saver is started.

The administrator can specify the settings for the screen saver explicitly using a combination of these policies. For a detailed explanation of each policy, right-click the policy, click Properties and then click the Description tab.

These settings reduce the danger of another user looking at your computer or using it improperly if you leave it without locking it.

To lock a computer, press Ctrl+Alt+Del, and click Lock Computer or press the Windows logo key and the L key.

Hiding the last username

If you set the following group policy, the last username used to log on is not displayed.

Computer Configuration\Windows Settings\Security Settings\Local Policy\Security options

If you set Interactive logon: Do not display last user name to Enable, the username used for the last logon is not displayed, reducing the danger of improper use.

Asking for a password after returning from hibernating or suspended status

If you set the following group policy, the computer will be locked when it returns from hibernating or suspended status and will always ask for a password.

User Configuration\Administrative Template\System\Power Management\Prompt for password on resume from hibernate / suspend

This setting reduces the risk of improper use if that a laptop PC in hibernating state is lost, because it always requires a password to be entered.

Preventing Installation from Removable Media

If you set the following group policy, you can restrict the installation of programs from removable media.

User Configuration\Administrative Templates\Windows Component\Windows Installer

If you set Prevent removable media source for any install to Enabled, it will no longer be possible to install programs from removable media such as CDs or floppy disks.

User Configuration\Administrative Templates\Control Panel\Add/Remove Programs

If you enable Hide the "Add a program from CD-ROM or floppy disk" option, Add a program from CD-ROM or floppy disk will be deleted from the Add Programs screen, and it will no longer be possible to install programs from removable media.

Setting these policies reduces the risk that unapproved applications will be installed.

Permissions for the root folder of the drive where Windows 2000 is installed

In Windows 2000, by default the Everyone group has full access (Everyone:F) to the root folder on the drive where the system is installed. This means that there is a risk that Trojan horses may be executed. Consider changing the permissions for the root folder. For more information, see http://support.microsoft.com/kb/327522/.

7. Related Links

Protecting computers from spyware

http://www.microsoft.com/athome/security/spyware/default.mspx
Step-by-Step Guide to Active Directory

http://www.microsoft.com/technet/prodtechnol/windowsserver2003/technologies/directory/activedirectory/stepbystep/default.mspx
List of Windows Server 2003 SP1 group policies

http://go.microsoft.com/fwlink/?LinkId=29911
Windows Rights Management Services (RMS)

http://go.microsoft.com/fwlink/?LinkId=50767
Security Guidance Center

http://go.microsoft.com/fwlink/?linkid=26697
� This white paper was originally produced by Windows Division in Microsoft Japan, to respond to local customers’ demand to become compliant with Personal Information Protection Laws newly enacted in Japan. However, requirement for security is universal, and this paper will help IT professionals in every country/region to secure their systems.


� Solutions have been tested with these versions. Windows XP Home Edition is not supported. These solutions are not compatible with the NEC PC-9800 series.


� You can only write-protect USB storage devices or restrict the use of SD cards with Windows XP SP2 or later. These settings do not work with Windows Server 2003 SP1.


� You can only write-protect CDs with Windows XP or later, or Windows Server 2003. This setting does not work in Windows 2000.


� In Windows 2000, click the View menu and clear the Show Policies Only check box.


� In Windows 2000, cipher.exe does not have the /u option.


� Select Logoff instead of Logon to set the logoff script.In this case, use the following procedure, substituting "logoff" for "logon."


� In Windows 2000, select Choose Columns on the View menu and choose the Attribute check box.


� Two computers were prepared with Pentium 4 CPUs (2.0GHz and 3.2GHz), 512MB of memory, Windows XP SP2 and the same files, and the encryption times were measured. The default encryption method was used.


� In Windows 2000, perform the following step instead of Step 5.


Click the View menu and clear the Show policies only check box.


� The distribution points on the sites you are connected to and all their child sites will be listed in the wizard. You can select any of these distribution points. Specify distribution points for all the sites which include clients where you want to install the encryption script.


� In Windows 2000 Server, click Browse this CD when the startup screen appears.


� This is called 200rkst.msi in Windows 2000 Server.


� In Windows 2000 Server, this is the Security tab.


� In Windows 2000 Server, the default setting for members of Pre-Windows 2000 Compatible Access is Everyone, not Authenticated Users, so you should select and delete Everyone.


� In Windows 2000 Server, click the Details button.


� To display the OFFLINE ADDRESS BOOK node, right-click Public Folder node and then click View System Folders.





